User’s Guide

Publication Number E3459-97005
July 2000

For Safety information, Warranties, and Regulatory information, see the pages
behind the index.

© Copyright Agilent Technologies 1994-2000
All Rights Reserved

E5900A Option 300
Emulation for the ARM7/ARM9



E5900A Option 300 Emulation for the ARM7/ARM9—
At a Glance

The emulator provides a low-cost way to debug embedded software for a
variety of ARM target systems.

Emulation Probe

The emulation probe is a stand-alone emulator. You can connect the
emulation probe to a debug port on the target system through the
provided target interface module (TIM). The emulation probe can be
controlled by a debugger on a host computer or by the Emulation
Control Interface on an Agilent Technologies 16600A/700A-series logic
analysis system.

The emulation probe lets you use the target processor’s built-in
background debugging features, including run control and access to
registers and memory.
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Computer
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Emulation Module and Target Interface Module

The emulation module plugs into your Agilent Technologies 16600A/
700A-series logic analysis system frame. The emulation module lets you
use the target processor’s built-in background debugging features,
including run control and access to registers and memory. A high-level
source debugger can use the emulation module to debug code running
on the target system. You can connect the emulation module to a debug
port on the target system through the provided target interface module
(TIM).

Emulafion Module
Target Inferface

Module (TIM)

345917

Emulation Migration

The emulation migration includes a target interface module and
firmware. Use the emulation migration if you already have an
emulation probe or an emulation module for another processor.




In This Book

This book documents the following products:

Emulator

Emulation Probe
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Includes
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Overview

This chapter describes:

e Setup flowchart

e Equipment used with the emulation probe

e (Connection sequences for the emulation probe
e Equipment used with the emulation module

e Additional information sources
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Overview
Setup Flowchart

Setup Flowchart
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Overview

Emulation Probe

Emulation Probe

Equipment supplied

An emulation probe.

A 12V power supply for the emulation probe.
A power cord.

A target interface module (TIM) circuit board.

An emulation probe loopback test board (Agilent part number E3496-
66502).

A 50-pin ribbon cable (connects the emulation probe to the target
interface module).

A 14-pin low density ribbon cable (connects the target interface module to
your target system).

A 20-pin low density ribbon cable (connects the target interface module to
your target system).

A 20-pin high density ribbon cable (connects the target interface module
to your target system).

This User’s Guide.
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Overview
Emulation Probe

Power Supply

Emulation Probe
Loopback Test
Board

14-pin
20-pin low
20 pin high

23459206

15



Overview
Emulation Probe

Minimum equipment required

The following equipment is required to use the emulation probe:

e A target system with the appropriate connector. The target system must
meet the criteria on page 83.

e A host computer, such as a PC or workstation. You can also connect the
emulation probe to an Agilent Technologies 16600A or 16700A logic
analysis system.

e A LAN (local area network) to connect the emulation probe to the host
computer.

e A user interface on the host computer, such as a high-level source
debugger or the logic analysis system’s Emulation Control Interface.
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Overview
Power-On/Power-0ff Sequence for the Emulation Probe

Power-On/Power-Off Sequence for the
Emulation Probe

To power on the system

With all components connected, power on your system as follows:
Logic analyzer, if you are using one.

Emulation probe.

Your target system.

To power off the system
Power off your system as follows:
Your target system.

Emulation probe.

Logic analyzer, if you are using one.

To connect the emulation probe to a power
source

The emulation probe does not have an On/Off switch. To power on the
emulation probe:
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Overview
Power-0On/Power-0ff Sequence for the Emulation Probe

1 Connect the power cord to the power supply and to a socket outlet.

s

3493206

-

2 Connect the 12V power cord to the back of the emulation probe.

e3493e07

The power light on the target side of the emulation probe will be illuminated.
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WARNING:

CAUTION:

Overview
Power-On/Power-0ff Sequence for the Emulation Probe

The emulation probe is shipped from the factory with a power supply and cord
appropriate for your country. If the cord you received is not appropriate for
your electrical power outlet type, contact your Agilent Technologies sales and
service office.

Use only the supplied Agilent Technologies power supply and cord. Failure to
use the proper power supply could result in electric shock.

Use only the supplied Agilent Technologies power supply and cord. Failure to
use the proper power supply could result in equipment damage.
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Overview
Connection Sequence (Emulation Probe only)

Connection Sequence (Emulation Probe only)

Disconnect power from the target system, emulation probe, and logic analyzer
before you make or break connections.

1 Connect the emulation probe to a LAN (page 28).
2 Connect the emulation probe to your target system (page 55).
3 Configure the emulation probe (page 63).

20



Overview
Emulation Module

Emulation Module

Equipment supplied

The equipment supplied with your emulation module includes:

An Agilent Technologies 16610A emulation module. If you ordered an
emulation module as part of your Agilent Technologies 16600A or 16700A-
series logic analysis system, it is already installed in the frame.

A target interface module (TIM) circuit board.

An emulation module loopback test board (Agilent part number E3496-
66502).

Firmware for the emulation module and software for the Emulation
Control Interface on a CD-ROM.

A 50-pin ribbon cable for connecting the emulation module to the target
interface module.

A 14-pin low density ribbon cable (connects the target interface module to
your target system).

A 20-pin low density ribbon cable (connects the target interface module to
your target system).

A 20-pin high density ribbon cable (connects the target interface module
to your target system).

One Torx T-10, on T-8, and one Torx T-15 screwdriver (if the emulation
module was not installed at the factory).

This User's Guide.
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Overview
Emulation Module

Emulation

User's Guide

14-pin
20-pin low
20-pin high

Test

‘ Board
Screwdrivers

e3¢59e18
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Overview
Emulation Module

Minimum equipment required

The following equipment is required to use the emulation module:

e An Agilent Technologies 16600A or 16700A logic analysis system.

e A user interface, such as a high-level source debugger or the logic analysis
system's Emulation Control Interface.
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Overview
Emulation Migration

Emulation Migration

This section lists equipment supplied with the emulation migration and lists
the minimum equipment required to use the emulation migration.

Equipment supplied

The equipment supplied with your emulation migration includes:

e A target interface module (TIM) circuit board.

e Firmware for the emulation module and/or updated software for the
Emulation Control Interface on a CD-ROM.

e A 14-pin low density ribbon cable (connects the target interface module to
your target system).

e A 20-pin low density ribbon cable (connects the target interface module to
your target system).

e A 20-pin high density ribbon cable (connects the target interface module
to your target system).

e This User's Guide.

Emulation Probe
Loopback Test

14-pin
20-pin low
20 pin high

User's Guide

e3459e21
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Overview
Minimum equipment required

Minimum equipment required

The following equipment is required to use the emulation migration:

An emulation module or emulation probe.
A 50-pin data cable (supplied with the emulation module or probe).
A method for connecting to the target system.

A host computer such as a PC, a workstation, or an Agilent Technologies
16600A or 16700A logic analysis system.

A user interface, such as a high-level source debugger or the logic analysis
system's Emulation Control Interface.
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Overview
Additional Information Sources

Additional Information Sources

Additional or updated information can be found in the following places:

Newer editions of this manual may be available. Contact your local Agilent
Technologies representative.

e Application notes may be available from your local Agilent Technologies
representative or on the World Wide Web at:
http://www.agilent.com/find/logicanalyzer

e If you have an Agilent Technologies 16600A or 16700A logic analysis
system, the online help for the Emulation Control Interface has additional
information on using the emulation module.

e The measurement examples include valuable tips for making emulation
and analysis measurements. You can find the measurement examples
under the system help in your Agilent Technologies 16600A/700A-series
logic analysis system.

26



Connecting the Emulation Probe to a
LAN
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Connecting the Emulation Probe to a LAN

You can connect your PC, workstation, or logic analysis system to the
emulation probe via a serial or LAN connection.

Serial connection

A serial connection allows you to complete all of the performance verification
tests and set LAN parameters. Other use of the serial port is not supported.

LAN connection

A LAN connection will allow you to make your measurements quickly and
easily. A few of the performance verification tests cannot be run over a LAN.

Recommended connection

Use a LAN connection for routine use, and a serial connection for LAN
configuration and for troubleshooting.
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Connecting the Emulation Probe to a LAN

Setting Up a LAN Connection to a PC or
Workstation

The emulation probe has two LAN connectors:

e A BNC connector that can be directly connected to an
IEEE 802.3 Type 10BASE2 cable (ThinLAN). When using
this connector, the emulation probe provides the
functional equivalent of a Medium Attachment Unit (MAU)
for ThinLLAN.

e AnIEEE 802.3 Type 10BASE-T (StarLAN) connector.

Use either the 10BASE2 or the 10BASE-T connector. Do not use both. The
emulation probe will not work with both connected at the same time.

You must assign an IP address (Internet address) to the emulation probe
before it can operate on the LAN. You can also set other network parameters
such as a gateway address. The IP address and other network parameters are
stored in nonvolatile memory within the emulation probe.

The emulation probe automatically sets a subnet mask based on the subnet
mask used by other devices on the network.

You can configure LAN parameters in any of the following ways:

e [Using the built-in terminal interface over a serial connection. This is the
most reliable method.

e Using BOOTP, which is part of the HP-UX, SunOS, and Solaris operating
systems.
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Connecting the Emulation Probe to a LAN

To obtain an IP address

Obtain the following information from your local network administrator
or system administrator:

e An IP address for the emulation probe.

You can also use a "LAN name" for the emulation probe, but you must
configure it using the integer dot notation (such as 127.0.0.1).

e The gateway address.

The gateway address is an IP address and is entered in integer dot notation.
The default gateway address is 0.0.0.0, which allows all connections on the
local network or subnet. If connections are to be made to workstations on
other networks or subnets, this address must be set to the address of the
gateway machine.

Find out whether port numbers 6470 and 6471 are already in use on
your network and if that use constitutes a conflict.

The host computer interfaces communicate with the emulation probe through
two TCP service ports. The default base port number is 6470. The second port
has the next higher number (default 6471).

In almost all cases, the default numbers (6470, 6471) can be used without
change. If necessary the default numbers can be changed if they conflict with
some other product on your network.

To change the port numbers, see page 32. If you have already set the IP
address, you can use a telnet connection instead of a serial connection to
connect to the emulation probe.
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Connecting the Emulation Probe to a LAN

3 Write down the link-level address of the emulation probe.
You will need this address if you use BOOTP to set the IP address.

The link-level address (LLA) is printed on a label above the LAN connectors
on the emulation probe. This address is configured in each emulation probe
shipped from the factory and cannot be changed.

IP Address of Emulation probe
LAN Name of Emulation Probe

Gateway Address

Link-Level Address of Emulation Probe

3



Connecting the Emulation Probe to a LAN

To configure LAN parameters using the built-in
terminal interface

Set configuration switches S1 through S4 to ON, and set the other
switches as appropriate for your serial interface.

Switch settings are printed on the bottom of the emulation probe. If you will
use a baud rate of 9600 baud, set the switches like this:

Connect an ASCII terminal (or terminal emulator) to the emulation
probe’s RS-232 port with a 9-pin RS-232 cable.

Complete instructions for setting up a serial connection begin on page 40.

Plug in the emulation probe’s power cord. Press the terminal’s
<RETURN> key a couple times. You should see a prompt such as "p>",
||?>l| OI' I|R>l|'

At this point, you are communicating with the emulation probe’s built-in
terminal interface.
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-i <internet>
-g <gat eway>

-p <port>

Connecting the Emulation Probe to a LAN

4 Display the current LAN configuration values by entering the lan

command:

R>

lan lan is disabled

lan -i 0.0.0.0

lan -g 0.0.0.0

lan -p 6470

Et hernet Address : 08000903212f

The "lan -i" line shows the current IP address (IP address) of the emulation
probe.

The Ethernet address, also known as the link level address, is preassigned at
the factory, and is printed on a label above the LAN connectors.

Enter the following command:
lan -i >[-g>] [-p >]
The lan command parameters are:

The | P address which you obtained from your network
admi ni strator.

The gateway address. Setting the gateway address all ows
access outside your |ocal network or subnet.

Thi s changes the base TCP service port nunber.
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Connecting the Emulation Probe to a LAN

The default numbers (6470, 6471) can be changed if they conflict with some
other product on your network. TCP service port numbers must be greater
than 1024. If you change the base port, the new value must also be entered in
the /etc/services file on the host computer. For example, you could modify the
line:

hp64700 6470/ t cp

The IP address and any other LAN parameters you change are stored in
nonvolatile memory and will take effect the next time the emulation probe is
powered off and back on again.

Disconnect the power cord from the emulation probe, and connect the
emulation probe to your network.

This connection can be made by using either the 10BASE-T connector or the
10BASE2 (BNC) connector on the emulation probe. Do not use both
connectors at the same time.

Set the configuration switches to indicate the type of connection that is
to be made.

Switch S1 must be set to OFF, indicating that a LAN connection is being made.

Switch S5 should be ON if you are connecting to the BNC connector:

Set all other switches to ON.
Connect the power cord to the emulation probe.

Verify your emulation probe is now active and on the network. See "To
verify LAN communications" on page 38.

Once you have set a valid IP address, you can use the telnet utility to connect
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Example

See Also

Connecting the Emulation Probe to a LAN

to the emulation probe, and use the lan command to change LAN parameters.

To assign an IP address of 192.6.94.2 to the emulation probe, enter the
following command:

R>lan -i 192.6.94.2

Now, cycle power on the emulation probe so that the new address will take
effect.

"Solving Problems," page 113, if you have problems verifying LAN
communication.

To configure LAN parameters using BOOTP

Use this method only on a workstation which is running bootpd, the BOOTP
daemon.

Make sure that BOOTP is enabled on your host computer.

If the following commands yield the results shown below, the BOOTP protocol
is enabled:

$ grep bootp /etc/services

boot ps 67/ udp

boot pc 68/ udp

$ grep bootp /etc/inetd. conf

bootps dgram udp wait root /etc/bootpd boot pd

If the commands did not yield the results shown, you must either add BOOTP
support to your workstation or use a different method to configure the
emulation probe LAN parameters.
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Connecting the Emulation Probe to a LAN

Add an entry to the host BOOTP database file, /etc/bootptab. For
example:

# d obal tenplate for options common to all Agilent
64700
# enmul ators and Emnul ati on Probes.
# Use a different gateway addresses if necessary.
hp64700 gl obal : \
:gw=0.0.0.0:\

- vmEaut o: \

thn:\

:bs=aut o:\

: ht =et her

# Specific emulator entry specifying hardware address
# (link-level address) and ip address.
hpprobe. di v. hp. com\

:tc=hp64700. gl obal : \

: ha=080009090B0E: \

11 p=192. 6. 29. 31
In this example, the "ha=080009090BOE" identifies the link-level address of
the emulation probe. The "ip=192.6.29.31" specifies the IP address that is
assigned to the emulation probe. The node name is "hpprobe.div.hp.com".

Connect the emulation probe to your network.

This connection can be made by using either LAN connector on the emulation
probe.

Set the configuration switches to indicate the type of connection that is
to be made.

Switch S1 must be set to OFF, indicating that a LAN connection is being made.
Switch S6 must be set to OFF to enable BOOTP mode.
Switch S5 should be set to OFF if you are connecting to the BNC connector

Switch S5 should be set to ON if you are connecting to the 10BASE-T
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See Also

Connecting the Emulation Probe to a LAN

connector.

55555555

Set all other switches to ON.

Connect the power cord to the emulation probe.
Verify that the power light stays on after 10 seconds.
The TP address will be stored in EEPROM.

Set switch S6 back to ON.

Do this so that the emulation probe does not request its IP address each time
power is cycled. The IP address is stored in EEPROM, so BOOTP does not
need to be run again. Leaving this switch on will result in slower performance,
increased LAN traffic, and even failure to power up (if the BOOTP server
becomes inactive).

Verify your emulation probe is now active and on the network. See "To
verify LAN communications" on page 38.

For additional information about using bootpd, refer to the bootpd (1M) man
page.
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Connecting the Emulation Probe to a LAN

NOTE:

To set the 10BASE-T configuration switches

Set switches S7 and S8 to ON unless one of the following conditions is true:
e [fthe LAN cable exceeds the standard length, set switch S7 to OFF.

The emulation probe has a switch-selectable, twisted-pair receiver threshold.
With switch S7 set to OFF, the twisted-pair receiver threshold is lowered by
4.5 dB. This should allow you to use cable lengths of up to about 200 meters. If
you use a long cable, you should consult with your LAN cabling installer to
ensure that:

e The device at the other end of the cable has long cable capability, and

e The cable is high-grade, low-crosstalk cable with crosstalk attenuation
of greater than 27.5 dB.

When switch S7 is set to ON, the LAN port operates at standard 10BASE-T
levels. A maximum of 100 meters of UTP cable can be used.

e If your network doesn’t support Link Beat integrity checking or if the
emulation probe is connected to a non 10BASE-T network (such as
StarLAN) set this switch to LINK BEAT OFF (0 or OPEN).

In normal mode (switch S8 set to ON), a link integrity pulse is transmitted
every 15 milliseconds in the absence of transmitted data. It expects to receive
a similar pulse from the remote MAU. This is the standard link integrity test
for 10BASE-T networks. If your network doesn’t support the Link Beat
integrity checking or if the emulation probe is used on a non 10BASE-T
network (such as StarLAN) set this switch to LINK BEAT OFF (OFF).

Setting switch S8 to OFF when Link Beat integrity checking is required by
your network will cause the remote MAU to disable communications.

To verify LAN communications

Verify your emulation probe is now active and on the network by
issuing a telnet to the IP address.

This connection will give you access to the emulation probe’s built-in terminal
interface.
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Connecting the Emulation Probe to a LAN

2 To view the LAN parameters, enter the lan command at the terminal

If You Have Problems

Example

interface prompt.
To exit from this telnet session, type <CTRL>D at the prompt.

The best way to change the emulation probe’s IP address, once it has already
been set, is to telnet to the emulation probe and use the terminal interface lan
command to make the change. Remember, after making your changes, you
must cycle power or enter a terminal interface init -p command before the
changes take effect. Doing this will break the connection and end the telnet
session.

If you encounter problems, refer to the "Solving Problems" chapter (page
113).

$ telnet 192.35.12.6

R>l an

lan i s enabl ed

lan -i 192.35.12.6

lan -g 0.0.0.0

lan -p 6470

Et hernet Address : 08000F090B30
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Connecting the Emulation Probe to a LAN
Setting Up a Serial Connection (Emulation probe only)

Setting Up a Serial Connection (Emulation
probe only)

To set up a serial connection, you will need to:

e Set the serial configuration switches

e (Connect a serial cable between the host computer and the emulation
probe

e Verify communications

Serial connections on a workstation

If you are using a UNIX workstation as the host computer, you need to use a
serial device file. If a serial device file does not already exist on your host, you
need to create one. Once it exists, you need to ensure that it has the
appropriate permissions so that you can access it. See the system
documentation for your workstation for help with setting up a serial device.

Serial connections on a PC

Serial connections are supported on PCs. You must use hardware handshaking
if you will use the serial connection for anything other than setting LAN
parameters.

If you are using a PC as the host computer, you do not need to set up any
special files.

To set the serial configuration switches

Set switch S1 to ON (RS-232).
Set switches S2-S4 to ON.

Set switch S5 to ON (HW HANDSHAKE ON) if your serial interface
uses the DSR:CTS/RTS lines for flow control. Set S5 to OFF (HW
HANDSHAKE OFF) if your serial interface uses software flow control
(XON/XOFF).

If your serial interface supports hardware handshaking, you should use it (set
switch S5 to ON). Hardware handshaking will make the serial connection
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Example

Connecting the Emulation Probe to a LAN
Setting Up a Serial Connection (Emulation probe only)

much more reliable.

Set switches S6-S8 for the baud rate you will use. These switch settings
are listed on the bottom of the emulation probe.

The higher baud rates may not work reliably with all hosts and user interfaces.
Make sure the baud rate you choose is supported by your host and user
interface.

To use a baud rate of 9600 baud, set the switches as follows:
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Connecting the Emulation Probe to a LAN
Setting Up a Serial Connection (Emulation probe only)

CAUTION:

To connect a serial cable

Use a grounded, shielded cable. If the cable is not shielded, or if the cable is
not grounded at the serial controller, the emulation probe may be damaged by
electrostatic discharge.

Connect an RS-232C modem cable from the host computer to the emulation
probe. The recommended cable is HP part number C2932A. This is a 9-pin
cable with one-to-one pin connections.

If you want to build your own RS-232 cable, follow the pinout shown in the
following figure:

)

O |9
41 O
O |8
3]0
O |7
210
O |6

é

E3490B08
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Serial Cable Pinout

Connecting the Emulation Probe to a LAN
Setting Up a Serial Connection (Emulation probe only)

Pin

Number Signal Signal Description

1 DCD Data Carrier Detect (not used)

2 D Transmit Data (data coming from Agilent
Technologies emulation probe)

3 RD Receive Data (data going to
Agilent Technologies emulation probe)

4 DTR Data Terminal Ready (not used)

5 GND Signal Ground

6 DSR Data Set Ready (Qutput from Agilent Technologies
emulation probe)

7 RTS Request to Send (Input to Agilent Technologies
emulation probe)

8 CTS Clear to Send (connected to pin 6)

9 RING Ring Indicator (not used)
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Connecting the Emulation Probe to a LAN
Setting Up a Serial Connection (Emulation probe only)

To verify serial communications

Start a terminal emulator program on the host computer.

If you are using a PC, the Terminal application in Microsoft Windows will work
fine.

If you are using a UNIX workstation, you can use a terminal emulator such as
cu or kermit.

Plug the power cord into the emulation probe.

When the emulation probe powers up, it sends a message (similar to the one
that follows) to the serial port and then displays a prompt:

Copyright (c) Agilent Technol ogi es 1987

All Rights Reserved. Reproduction, adaptation, or translation wthout

pri or

written perm ssion is prohibited, except as allowed under copyright

| aws.

E3499B Series Enul ati on System

Ver si on:
Locati on:

A. 07. 57 04Mar 99
CGenerics

E3459B ARM// 9 JTAG Enul at or

Ver si on:

R>

See Also

B. 02. 00 17Jun99 10: 42

The version numbers may be different for your emulation probe.
Press the Return or Enter key a few times.

You should see a prompt such as "p>", "R>", or "?>".

For information about the commands you can use, enter ? or help at the
prompt.

"Problems with the Serial Interface," page 132.
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CAUTION:

Installing the Emulation Module

This chapter shows you how to install an emulation module in your Agilent
Technologies 16600A/700A-series logic analysis system.

If your emulation module is already installed in your logic analysis system

frame, you may skip this chapter.

Electrostatic discharge can damage electronic components. Use grounded
wrist straps and mats when you handle modules.
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Installing the Emulation Module

To install the emulation module in a 16700A-
series logic analysis system or a 16701A
expansion frame

You will need T-10 and T-15 Torx screw drivers.

1 Turn off the logic analysis system and REMOVE THE POWER CORD.
Remove any other cables (including mouse or video monitor cables).

2 Turn the logic analysis system frame upside-down.

3 Remove the bottom cover.

4 Remove the slot cover.

You may use either slot.
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Installing the Emulation Module

5 Install the emulation module.

16700024

6 Connect the cable and re-install the screws.

You may connect the cable to either of the two connectors. If you have two
emulation modules, note that many debuggers will work only with the "first"
module: the one toward the top of the frame ("Slot 1"), plugged into the
connector nearest the back of the frame.

7 Reinstall the bottom cover, then turn the frame right-side-up.

8 Plug in the power cord, reconnect the other cables, and turn on the
logic analysis system.

The new emulation module will be shown in the system window.
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Installing the Emulation Module

To install the emulation module in a 16600A-
series logic analysis system

You will need T-8, T-10, and T-15 Torx screw drivers (supplied with the
modules).

1 Turn off the logic analysis system and REMOVE THE POWER CORD.
Remove any other cables (such as probes, mouse, or video monitor).

2 Slide the cover back.

16600e14

4 Install the emulation module.
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Installing the Emulation Module

5 Connect the cable and re-install the screws.

N NN
@@%%%g%@@%@%%%w
L
s L

6 Reinstall the cover.
Tighten the screws snugly ( 2 Nh or 18 inch-pounds).

7 Plug in the power cord, reconnect the other cables, and turn on the
logic analysis system.

The new emulation module will be shown in the system window.
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Installing Software on a 16600A/700A

This chapter explains how to install the software you will need for your
emulator.

Installing and loading

Installing the software will copy the files to the hard disk of your logic analysis
system. Later, you will need to load some of the files into the appropriate
hardware module.

What needs to be installed

If you ordered an emulation module with your logic analysis system, the
software was installed at the factory.

The following files are installed from the CD-ROM:

¢ Emulation module firmware
¢ Emulation Control Interface

e Other files which support logic analysis
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Installing Software on a 16600A/700A

U W W N
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To install the software from CD-ROM (16600A/
700A)

Installing a processor support package from a CD-ROM will take just a few
minutes. If the processor support package requires an update to the Agilent
Technologies 16600A/700A operating system, installation may take
approximately 15 minutes.

If the CD-ROM drive is not connected, see the instructions printed on the CD-
ROM package.

Turn on the CD-ROM drive first and then turn on the logic analysis
system.

If the CD-ROM and analysis system are already turned on, be sure to save any
acquired data. The installation process may reboot the logic analysis system.

Insert the CD-ROM in the drive.

Click the System Admin icon.

Click the Software Install tab.

Click Install....

Change the media type to "CD-ROM" if necessary.

Click Apply.

From the list of types of packages, double-click "PROC-SUPPORT."
A list of the processor support packages on the CD-ROM will be displayed.
Click on the "ARM" package.

If you are unsure whether this is the correct package, click Details for
information about the contents of the package.

Click Install.
The Continue dialog box will appear.
Select Continue.

The Software Install dialog will display "Progress: completed successfully"
when the installation is complete.
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Installing Software on a 16600A/700A

11 If required, the system will automatically reboot. Otherwise, close the
software installation windows.

See Also The instructions printed on the CD-ROM package for a summary of the
installation instructions.

The online help for more information on installing, licensing, and removing
software.
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Connecting the Emulator to the Target
System
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Connecting the Emulator to the Target System

The Agilent Technologies emulator is connected to a target system through
one of the IEEE 1149.1 (JTAG) Port connectors. The included connectors are
a 14-pin ARM Embedded Ice connector, a 14-pin VLSI connector, a 14-pin TI
connector, a 20-pin low density ARM/Agilent connector, and a 20-pin high
density ARM/Agilent connector.

To test the Agilent Technologies emulator

If this is the first time that you have used the emulator, you should run the
built-in performance verification test before you connect to a target system.
Refer to the "Solving Problems" chapter (beginning on page 113) for
information on performance verification.
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Connecting the Emulator to the Target System

To connect to a target system via the debug
port

In order to connect the emulator to the microprocessor, one of the supported
connectors must be available on the target system (see page 83 for
information on designing a target system for use with the emulator).

Remove power from the target system and the emulator.

Plug one end of the 50-pin cable into the emulator.

3 Plug the other end of the 50-pin cable into the target interface module.

Choose the appropriate ribbon cable for the connector that is on your
target system.

For a target system using either of the 20-pin headers, connect one end
of the ribbon cable to the target interface module.
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Connecting the Emulator to the Target System

Pin 1 Viref | O O| Pin 2. Vsupply
Pin 3: nTRST | © O] Pin 4 GND o
Pn 5 TDI | O O] Pin &6 GND :
Pn 7 TMS | O O| Pin 8 GND
Pn 9 TCK 1 O O] Pin 10 GND |:||:||:|
Pin 11 RT[K[ O O| Pin 12 GND
Pin 13: TDO | O O | Pin 14 GND | ELulbiif
Pin 15 nSRST | O O] Pin 16 GND
Pin 17 DBGRAQ | O O | Pin 18 GND
Pin 19: DBGACK | O O | Pin 20: GND

34591

ARM/Agilent 20-pin Connector*

* Recommended for new designs.

For a target system using the 14-pin header, match the connector on
the target system with one of the following diagrams.

Pin 1 Viref | O O| Pin 2: GND .
Pin 3. nTRST | O O Pin 4. GND =
—/
PHS TDI | O O Pin 6 GND
Pin 7- TMST O O | Pin 8 GND il
Pin 9 TCK | O O Pin 10: GND |
Pin 11 TDO | O O Pin 12 nSRST
Pin 13- Viref | O O| Pin 14: GND

e3459e1z

ARM Embedded ICE 14-pin Connector
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Pin 1 TMS

Pin 3 TDI

Pin 5 TVCC
Pin 7. TDO[

Pin 9 TCK_RET

Pin 11 TCK

Pin 13: EMUO

OO0O00000
CRCHCRCRONOR®

TI XDS510 14-pin Connector

Pin 1 +5V
Pin 3 nTRST
Pin 5 TDI
Pn 7 TMS [
Pin 9 TCK
Pin 11: TDO
Pin 13 3.3V

O000000
OO0O0000CO0

Connecting the Emulator to the Target System

Pin 2. nTRST

Pin 4 GND 55

Na pin (key) 2

Pin 8. GND '|:||:||:|

Pin 10° GND

Pin 12 nICERST

Pin 14 EMU1 .
e345%e13

Pin 2. GND o

Pin 4. PNO/GNDx —

Pin 6: PN1/GND= |:||:||:|

Pin 8 PN2/GNDx

Pin 10 PT/GNDx |

Pin 12. nRST

Pin 14 GND

* = PN[2:0] and PT are used for the VLSI MDP board

and are grounded on other VLSI targets.

VLS| Jumpstart 14-pin Connector

CAUTION:

Connect only one ribbon cable to the target interface module at any one time.

Connecting several cables may result in damage to the target system.

6 Plug the ribbon cable into the appropriate connector on the target

interface module.

7 Plug the other end of the selected ribbon cable into the debug port on

the target system.

8 Turn on the power to the emulator, then turn on the power to the

target system.

59



Connecting the Emulator to the Target System

Signal descriptions (14-pin connectors)

This section describes signals which differ from the descriptions of the signals
for the Agilent/ARM 20-pin connector described on page 85.

ARM 14-pin connector

TDO, TDI, TMS,TCK: Same as Agilent/ARM 20 pin

Vtref signal. The Vtref signal is used to sense when the target system
is connected to the emulator. This signal is also used as a reference
voltage for all signals driven by the emulator. The emulator does not
use this pin for power.

nTRST: Input: The nTRST signal is the JTAG reset signal. Most target
systems implement a reset by holding TMS high for 5 consecutive clock
cycles. nTRST can be used as a substitute for that operation.

nSRST: Input: target reset.

TI 14-pin connector

TDO, TDI, TMS,TCK: Same as Agilent/ARM 20 pin.

TVCC : Output from target system; 0 to 1 volt O system is not powered.
The emulator will not drive TDO, TDI, TMS,TKC. 1to 5V O the target system
is powered. The emulator will drive TDO,DTI, TMS,TCK.

EMUO, EMU1: No connection on emulator.

nICERST: Input: target reset.

VLSI 14-pin connector
TDO, TDI, TMS,TCK: Same as Agilent/ARM 20 pin.
+5V: Output. No connection on emulator.

3.3V: Output. 0 to 1 volt O system is not powered. The emulator will not
drive TDO, TDI, TMS,TKC. 1to 5V O the target system is powered. The
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Connecting the Emulator to the Target System

emulator will drive TDO,DTI, TMS,TCK.
nRST: Input: target reset.

PNO/GND, PN1/GND, PN2/GND,PT/GND: Target input. On most VLSI
targets these pins are grounded. On the VLSI MDP board these pins are
inputs to the target which select which processor is being addressed. The
emulator drives these pins with a high on PT and a low on PNO, PN1, PN2.
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Connecting the Emulator to the Target System
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Configuring the Emulator

The emulator has several user-configurable options. These options may
be customized for specific target systems and saved in configuration
files for future use.

The easiest way to configure the emulator is through the Emulation
Control Interface in an Agilent Technologies 16600A or 16700A
logic analysis system.

If you use the Emulation Control Interface, please refer to the online
help in the Configuration window for information on each of the
configuration options.

Other ways to configure the emulator are by using;:

e the emulator’s built-in terminal interface
e your debugger, if it provides an “emulator configuration” window which
can be used with this Agilent Technologies emulator

What can be configured

The following options can be configured using the Emulation Control
Interface or using built-in commands:

Processor type

Availability of DBGACK and DBGRQ signals
Restriction to real-time runs

JTAG clock speed

Endian mode

Debug communications channel
Coprocessor register RAM address
Reset behavior

Vector catch register

Trigger out behavior

Break in behavior
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Configuring the Emulator

To configure using the Emulation Control
Interface

The easiest way to configure the emulator is to use the Emulation
Control Interface.

Start an Emulation Control Interface session.

In the system window, click the Emulation Control Interface icon, and
then select Start Session....

Open a Configuration window.

Select Configuration... from the Emulation Control Interface icon or
from the Navigate menu in any Emulation Control Interface window.

Slot 1

Emulation Hodule

= End Session...

"Run Cantrol,..
Load Executable,,.
Breakpoints, ..
Registers, ..
Memary, ..

I-0,,.

Memory Dizassembly, ..

StatussError Log,..

Command Line, ..

Confizuration...

File Mavigate Help
"Break In" Port: Break On Rising Edge ‘JE
"Trigger Out" Port: High On Break —4
JTAG Clock Speed: 10 MHz —
The signal DBGACK is available: Tes o
The signal DBGREQ iz available: Tes —

Memory System Endian Mode: Little -

g

Frocessor Type: Arm7TOMI

3 Set the configuration options, as needed.

Configuration changes will take effect when you close the configuration
window or when you move the mouse pointer outside the window.

4 Save the configuration settings.

To save the configuration settings, open the File Manager window and
click Save....
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See Also

Configuring the Emulator

Help Help on this window in the Configuration window for
information on each of the configuration options.

Help in the Emulation Control Interface menu for help on starting an
Emulation Control session.

See Also

To configure using the built-in commands

If you are unable to configure the emulator with the Emulation Control
Interface or a debugger interface, you can configure the emulator using
the built-in “terminal interface” commands.

Connect a telnet session to the emulator over the LAN.

For example, on a UNIX system, for an emulator in Slot 1 enter:
tel net LAN address 6472

Enter cf to see the current configuration settings.

Use the cf command to change the configuration settings.

Enter hel p cf for help on the configuration commands.

For information on connecting using telnet, and for information on
other built-in commands, see 118.
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Configuring the Emulator

Example

To see a complete list of configuration items, type hel p cf . This
command displays:

cf - display or set erulation configuration

cf - display current settings for all config itens
cf <item> - display current setting for specified <itenp
cf <itenmp=<val ue> - set new <val ue> for specified <itenr

cf <item> <itenp=<val ue> <itenp - set and display can be conbi ned
hel p cf <itenmr - display long help for specified <itenp

--- VALI D CONFI GURATI ON <itenm> NAMES ---
pr oc - Set type of Arm Processor

reset - RESET actions

rrt - Enable or Disable Restriction to Real-Tine Runs
breakin - Select BNC break input option

trigout - Select BNC trigger output option

dbgack - Toggle avail ability of DBGACK

dbgr eq - Toggle availability of DBGREQ

speed - Set JTAG Cl ock Divisor

endi an - Specify Big or Little Endian

cpar ea - RAM regi on used by cpreg conmmand

conmms - Enabl e debug conmmuni cations channel polling

M

To see a more detailed description of any configuration item, use
the command “help cf <item>". For example:

M>help cf rrt
Enabl e or Disable Restriction of Real -Tine Runs

cf rrt=no
cf rrt=yes

Wien enabl ed and while the processor is running the user program any
command that requires a break to the monitor will be rejected except ‘rst’,
‘b’ ‘ror's’.

When disabled, commands that require a break to the monitor will alway be
accepted.
M>
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Configuring the Emulator

To see a list of the current configuration settings, use “cf™

M>cf

cf proc=ArmvTDM

cf reset=auto

cf rrt=no

cf breakin=rising

cf trigout=nonhigh

cf dbgack=no

cf dbgreqg=no

cf speed=3

cf endian=little

cf cparea=20

cf comrs=of f
To configure using a debugger
Because the Agilent Technologies emulator can be used with several
third-party debuggers, specific details for sending the configuration
commands from the debugger to the emulator cannot be given here.
However, all debuggers should provide a way of directly entering
terminal mode commands to the emulator. Ideally, you would create a
file that contains the modified configuration entries to be sent to the
emulator at the beginning of each debugger session.

See Also Information about specific debuggers in Chapter 8, “Using the

Emulator with a Debugger,” beginning on page 87.

Your debugger manual.
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Configuring the Emulator
Configuration Items

Configuration Items

The configuration items must be set correctly for each target system.

To set the type of ARM processor

Processor Built-in command
Arm7TDMI (default) cf proc=Arm7TDMI
Arm7DI cf proc=Arm7DI
Arm710T cf proc=Arm710T
Arm720T cf proc=Arm720T
Arm740T cf proc=Arm740T
Arm 920T cf proc=Arm920T
Arm 940T cf proc=Arm940T
Arm 966ES cf proc=Arm966ES

The cf save -s command will store the processor type configuration
in the emulator’s flash memory. The cf save -r command will restore
this configuration.
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Configuring the Emulator
Configuration Items

To configure the availability of DBGACK and
DBGRQ

The Agilent Technologies emulator will make use of the DBGACK and
DBGRQ signals if they are available on the debug port connector.

The DBGACK signal allows the emulator to quickly detect entry or exit
from debug mode. Also, the emulator is able to start or stop the logic
analyzer through the "TRIGGER OUT" of the emulator.

The DBGRQ signal is used to quickly enter debug mode after receiving
a "BREAK IN" signal from the logic analyzer. This allows the logic
analyzer triggering capability to be used for complex breakpoints.

To make use of these signals, the emulator must be configured
correctly. The following cf commands allow the specification of
whether each signal is connected or not.

Emulator configuration

Value Emulator configured for Built-in command

yes The corresponding signal is cf dbgack=yes
connected and will be used by cf dbgreq=yes
the emulator.

no The corresponding signal is not  cf dbgack=no
connected and will not be used cf dbgreq=no
by the emulator. (Default)
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Configuring the Emulator
Configuration Items

To configure restriction to real-time runs

Real-time runs configuration

Value Emulator configured for Built-in command

no Allows commands which break to the cf rrt=no
monitor. Examples include commands
which display memory or registers. These
commands break to the monitor to access
the target processor, then resume the
user program. (Default)

yes No commands are allowed which break to  cf rrt=yes
the monitor, except “break,” “reset,”
“run,” or “step.” The processor must be
explicitly stopped before these
commands can be performed.

If your debugger allows displaying or modifying memory or registers
while the processor is running, you must set rrt=no in order to use this
feature.
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Configuring the Emulator
Configuration Items

To configure the JTAG clock speed
(communication speed)

The Agilent Technologies emulator needs to be configured to
communicate at a rate which is compatible with your target processor.
The JTAG Clock speed is independent of processor clock speed. In
general, speed=1 can always be used and provides the best
performance. With some target systems that have additional loads on
the JTAG lines or with target systems that do not quite meet the
requirements described in the "Designing a Target System" chapter
(page 83), setting speed to a slower setting may enable the probe to
work. Some targets also have problems if the JTAG clock speed is set
too slow, particularly at the 156 kHz setting.

TCK clock speed configuration

Value TCK clock is at least Built-in command
1 10 MHz (default) cf speed=1
2 5 MHz cf speed=2
3 2.5 MHz cf speed=3
4 1.25 MHz cf speed=4
5 625 kHz cf speed=5
6 312 kHz cf speed=6
7 156 kHz cf speed="7
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Configuring the Emulator
Configuration Items

To configure the endian mode of the target
system

Because the ARM7 processor is capable of being configured as either
big-endian or little-endian, the emulator must know which
configuration the target system is configured for.

Processor endian configuration

Value Emulator configured for Built-in command
little Little endian (Default) cf endian=little
big Big endian cf endian=big

To configure the coprocessor register RAM
address

Reading and writing coprocessor registers requires a small area of
target system RAM. The contents of this RAM is saved before the RAM
is used and the original contents is restored after it is used. The

cpar ea configuration item specifies the starting address of an 80 byte
block of target system memory that must be readable and writable by
the emulator. The default address is 20.

For example:

cf cpar ea=40

will start the cparea at address 40.
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Configuring the Emulator
Configuration Items

To configure debug communications channel
polling

Debug communication channel configuration

Value Meaning Built-in command

off Disables polling for the debug cf comms=off
communications channel.

on Enables polling for the debug cf comms=on
communications channel
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Configuring the Emulator
Configuration Items

To set up the debug communication channel

Use the following commands to setup and use the debug
communication channel.

Command

Action

comin -c

Displays comms control register status.

Example Output:

control=0 Write and read registers are clear.

control=1 Data written to the comms data read register.
control=2 Data available in the comms data write register.
control=3 Data available in both registers.

comm -d

Display comms data buffer (max=64 values) Example output:
Count=2

XXXXXXXX

XXXXXXXX

comm -m <count>,

<value0>,
<valuel >...

Modify comms data read register.

comm -m <count>

Number of values to be entered (max=64).

comm -r

Clear the write buffer.

comim -v

Enables verbose messages for data in comms data buffer.

comim -v enable

Enables verbose messages for data in comms data buffer.
(Same as comm -v.)

comm -v disable

Disables verbose messages for data in comms data buffer.

comm -w

Display the number of words in the comms write buffer

See Also

The ARM7 data sheet for more information on the debug
communications channel.
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Configuring the Emulator
Configuration Items

To configure the emulator to work with a
COpProcessor

The firmware supports the description and access of coprocessors for
the ARM core. Use the following commands to describe coprocessors.

cpdesc -d <CP#> <type> <reg> <size> <nbit> <rdbits>
cpdesc -r <CP#> R <reg> <size> <read0> <readl>

cpdesc -r <CP#> W <reg> <size> <write0> <writel>

cpdesc -r <CP#> B <reg> <size> <read0> <readl> <wite0>
<witel>

cpreg [-r <read0>] <CP#> <reg> - displays coprocessor registration

cpreg -s [-w <write0>] <CP#> <reg> <valuel> [<valuel>]
- sets the processor register

cpdesc <CP#> - displays the description for the specified CP

Parameter Description
<CP#> The coprocessor number
<type> R, W, or B for read, write, or both
<reg> A single register number or range (eg: 1 or 3...6)
<size> The size of register in bytes (hex)
<nbit> Bit 22 in an LDC or SDC instruction
<rdbits> Bits 15..12 in an LDC or SDC instruction
<read0> Bits 7..0 in an MRC instruction
<readl> Bits 23..16 in an MRC instruction
<write0> Bits 7..0 in an MCR instruction
<writel> Bits 23..16 in an MCR instruction
NOTE: cpdesc for a register already specified will overwrite previous data.
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Configuring the Emulator
Configuration Items

Example usage of cpdesc and cpreg

To setup a description to read coprocessor 15 register 0 (ID register)
for the ARMT720T.

cpdesc -r 1I5R 04 0000 #ID register, read only
cpreg 150 #Reads CP15 c0
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Configuring the Emulator
Configuration Items

To configure the reset behavior

The reset configuration item controls what happens when a reset
occurs.

Reset configuration

Value Emulator configured for Built-in command

auto A RESET will break into monitor cf reset=auto
and restore watchpoint registers
only when watchpoint registers
are being used. (Default)

tomon A RESET will break into monitor. c¢f reset =t onon
(break) Watchpoint registers will be

restored. The processor will

remain in monitor until another

ommand causes it to exit.

touser A RESET will not break into cf reset=touser
(continue) monitor. Watchpoint registers will
not be restored.

restart A RESET will break into monitor. cf reset=restart
Watchpoint registers will be
restored and the user program
will begin running.

Note that these actions occur only when the RESET signal is
deasserted. Selecting the Reset button in the Emulation Control
Interface (or using the built-in r st command) asserts RESET
continuously until another command causes RESET to be deasserted.
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Configuring the Emulator
Configuration Items

To configure the vector catch register
(ARM920T/940T/966ES only)

This configuration item sets and displays the vector catch register,
which defines which conditions will cause the processor to enter debug
mode.

Vector catch register configuration

Bit Meaning Built-in command

7 FRQ cf vcatch=val ue
6 IRQ

5

4 D_Abort

3 P_Abort

2 SWI

1 Undef

0 Reset

Example

To set the vector catch register for SWI and RESET, set it to binary
00000101:

cf vcatch=0x5
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Configuring the Emulator
Configuration Items

To configure the Trigger Out BNC (Emulation
Probe only)

With an emulation module, this configuration item is always set to the default
setting and cannot be changed with a cf command. The Intermodule window
of the logic analyzer must be used instead.

Trigger out configuration

Value The Trigger Out BNC will Built-in command
fixhigh Always be high cf trigout=fixhigh
fixlow Always be low cf trigout=fixlow
monhigh Go high when the processor is cf trigout=monhigh

running in background (Default)

monlow Go low when the processor is cf trigout=monlow
running in background

To configure the Break In BNC (Emulation
Probe only)

With an emulation module, this configuration item is always set to the default
setting and cannot be changed with a cf command. The Intermodule window
of the logic analyzer must be used instead.

Break in configuration

Value The Break In BNC will Built-in command

off Inputs to the Break In BNC willbe  cf breakin=off
ignored.

rising The emulator will cause a breakon  cf breakin=rising

arising edge. (Default)

falling The emulator will cause a breakon  cf breakin=falling
a falling edge.
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Configuring the Emulator
Testing the emulator and target system

See Also

Testing the emulator and target system

After you have connected and configured the emulator, you should
perform some simple tests to verify that everything is working.

Chapter 11, “Solving Problems,” beginning on page 113, for information
on testing the emulator hardware.

To test memory accesses

Start the Emulation Control Interface and configure the
emulator, if necessary.

Open the Memory window.

Write individual locations or fill blocks of memory with patterns
of your choosing.

The access size is the size of memory access that will be used to write
or read the memory values.

Use the Memory I/0 window to stimulate I/O locations by reading
and writing individual memory locations.
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Testing the emulator and target system

To test with a running program

To more fully test your target, you can load simple programs and
execute them.

1 Compile or assemble a small program and store it in a Motorola S-
Record or Intel Hex file.

2 Use the Load Executable window to download the program into
RAM or flash memory.

3 Use the Breakpoints window to set breakpoints. Use the
Registers window to initialize register values.

The new register or breakpoint values are sent to the processor when
you press the Enter key or when you move the cursor out of the
selected register field.

4 In the Run Control window, click Run.

5 Use the Memory Mnemonic window to view the program and use
the Memory window to view any output which has been written
to memory.
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Designing a Target System for the Emulator

This chapter will help you design a target system that will work with the

Agilent Technologies emulator.

Designing the JTAG connector

There are four different “standards” for ARM JTAG target system headers:

ARM Embedded ICE 14-pin (0.100 inch pin spacing)
VLSI Jumpstart 14-pin (0.100 inch pin spacing)
TI XDS510 14-pin (0.100 inch pin spacing)

Agilent/ARM 20-pin low density (0.100 inch pin spacing)

The 14-pin connectors are supported by the emulator, but should not be
designed into new systems due to their susceptibility to noise and cross-talk.
New designs should use the Agilent/ARM 20-pin connector described in this

chapter.

254 mm

{0700 .
T

19 20

4 254 mm
0.100 in.

345910

KKK KNXKNKKKKX
XXX KKNXKXKKKX

Pin 1 Viref
Pn 3: nTRST
Pin 5 TDI
Pn 7 TMS
Pn 9 TCK
Pin 11 RT[K[
Pin 13: TDO
Pin 15 NnSRST
Pin 17. DBGRQ
Pin 19 DBGACK

O00O0O0O0O0OOC

Pin
Pin
Pin
Pin
Pin
Pin
Pin
Pin
Pin
Pin

Vsupply
GND
GND
GND
GND

- GND
- GND
- GND
- GND
- GND

345915
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Signal descriptions (20-pin connector)

Required Signals

Vtref signal. The Vtref signal is used to sense when the target system
is connected to the emulator. This signal is also used as a reference
voltage for all signals driven by the emulator. The emulator does not
use this pin for power.

TDI signal. The TDI signal is a core JTAG signal and should be
connected to TDI on the target.

TDO signal. The TDO signal is a core JTAG signal and should be
connected to TDO on the target.

TCK signal. The TCK signal is a core JTAG signal.

TMS signal. The TMS signal is a core JTAG signal.

Strongly recommended signals

DBGRQ signal. The DBGRQ signal is used to quickly enter debug
mode after receiving a "BREAK IN" signal from the logic analyzer. This
allows the logic analyzer triggering capability to be used for complex
breakpoints. Without DBGRQ), the processor must be stopped by using
the JTAG scan chains, and the processor may not stop until several
hundred instructions have been executed. This may cause
complications when attempting to correlate the state of the logic
analyzer and the emulator after the breakpoint has been reached. In
general, DBGRQ is much more useful than DBGACK for system debug.

DBGACK signal. The DBGACK signal is used to quickly detect entry
or exit from debug mode. If DBGACK is available, then the "TRIGGER
OUT" signal from the emulator can be used to start or stop the logic
analyzer. Without DBGACK, the emulator must do polling over the
JTAG scan chains to determine when the processor is in debug mode.
Without the use of DBGACK, there will be a substantial and variable
delay between the processor stopping and "TRIGGER OUT" being
driven. This may cause some difficulty in correlating the trace of the
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logic analyzer with the exact time that the processor entered debug
mode.

Optional signals

VSupply signal. The VSupply signal is used by some JTAG controllers
as a power source. The emulator does not use this pin for power. This
pin should be left unconnected if it is not available. If it is available,
then the emulator can accept OV - 5V at this pin.

nTRST signal. The nTRST signal is the JTAG reset signal. Most target
systems implement a reset by holding TMS high for 5 consecutive clock
cycles. nTRST can be used as a substitute for that operation.

nSRST signal. The nSRST signal is a current limited, open collector
signal that is driven and monitored by the emulator. nSRST is
connected to the ARM signal nRESET. If this signal is not available,
then the emulator will be unable to reset the target system.

Unused signals

RTCK signal. The emulation probe does not use the RTCK signal.

Electrical requirements for the TDO, TDI, TCK,
TMS and nTRST signals

TDO, TDI, TCK, TMS and nTRST signal traces between the JTAG
connector and the ARM target must be less than 3 inches long. If these
signals are connected to other nodes, the other nodes must be daisy
chained between the JTAG connector at one end and the ARM7
microprocessor at the other end. These signals are sensitive to
crosstalk and must not be routed along active signals such as clock
lines on the target board.

The TDI, TCK, TMS and nTRST signals must not be actively driven by
the target system when the debug port is being used.
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Using the Emulator with a Debugger

Several prominent companies design and sell state-of-the-art source
debuggers which work with the Agilent Technologies emulation module and
emulation probe.

Benefits of using a debugger

The debugger will enable you to control the execution of your processor from
the familiar environment of your debugger. Using a debugger lets you step
through your code at the source-code level.

With a debugger connection, you can set breakpoints, single-step through
source code, examine variables, and modify source code variables from the
debugger interface. The debugger can also be used to download executable
code to your target system.

Using a debugger to connect to the emulator allows the entire design team to
have a consistent interface from software development to hardware/software
integration.

Debugger interfaces must be ordered directly from the debugger vendor.

Compatibility with other logic analysis system tools

You can use your logic analysis system to collect and analyze trace data while
you use your debugger. If you are using an X windows workstation or a PC
with an X terminal emulator, you can display the logic analyzer windows right
next to your debugger.




Using the Emulator with a Debugger

Minimum requirements

To use a debugger with the emulator, you will need:

e A debugger which is compatible with the emulator
e A LAN connection to the PC or workstation that is running the debugger

e X windows or an X terminal emulator, such as Reflection X on a PC. This is
required only if you wish to have the logic analysis system user interface
displayed on your PC or workstation screen, along with the debugger.

Is your debugger compatible with the emulator?

Ask your debugger vendor whether the debugger can be used with an Agilent
Technologies emulation module or Agilent Technologies emulation probe (also
known as a "processor probe" or "software probe").

LAN connection

You will use a LAN connection to allow the debugger to communicate with the
emulator.

Compatibility with the Emulation Control Interface

Do not use the logic analysis system's Emulation Control Interface and your
debugger at the same time.
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Setting up Debugger Software

CAUTION:

See Also

Setting up Debugger Software

The instructions in this manual assume that your PC or workstation is already
connected to the LAN, and that you have already installed the debugger
software according to the debugger vendor’s documentation.

To use your debugger with the emulator, follow these general steps:

e (Connect the emulator to your target system (see page 56).

e (Connect the emulator or logic analysis system to the LAN (page 91).

e Export the logic analysis system's display to your PC or workstation
(page 93).

e (Configure the emulator (page 64).

e Begin using your debugger.

If you use the Emulation Control Interface to configure the emulator,
remember to end the Emulation Control Interface session before you start the
debugger.

Do not use the Emulation Control Interface at the same time as a debugger.
The Emulation Control Interface and debuggers do not keep track of
commands issued by other tools. If you use both at the same time, the tools
may display incorrect information about the state of the processor, possibly
resulting in lost data.

Refer to the documentation for your debugger for more information on
connecting the debugger to the emulator.
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Setting up Debugger Software

To connect the logic analysis system to the
LAN

Information on setting up a LAN connection is provided in the online help or
installation manual for your logic analysis system.

Your debugger will require some information about the LAN connection before
it can connect to the emulator. This information may include:

e [P address (Internet address) or LAN name of the logic analysis system.
e Gateway address of the logic analysis system.

e Port number of the emulator.

Port numbersfor emulators

Port number Use for

Debugger connections

6470 Slot 1 (First emulator in an Agilent Technologies 1660A/
700A-series logic analysis system)

6474 Slot 2 (Second emulator in an Agilent Technologies
16700A-series system)

6478 Slot 3 (Third emulator in an expansion frame)

6482 Slot 4 (Fourth emulator in an expansion frame)

Telnet connections

6472 Slot 1 (First emulator)

6476 Slot 2 (Second emulator)

6480 Slot 3 (Third emulator)

6484 Slot 4 (Fourth emulator)

Write the information here for future reference:

IP Address of Logic Analysis System

LAN Name of Logic Analysis System

Gateway Address

Port Number of Emulator
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To change the port number of an emulator

Some debuggers do not provide a means to specify a port number. In that
case, the debugger will always connect to port 6470 (the first emulator). If you
need to connect to another module, or if the port number of the first module
has been changed, you must change the port number to be 6470.

To view or change the port number:

Click on the emulation module icon in the system window of the logic
analysis system, then select Update Firmware.

Select Modify Lan Port...
If necessary, enter the new port number in the Lan Port Address field.

The new port number must be greater than 1024 and must not already be
assigned to another emulator.

See Also

To verify communication with the emulator

Telnet to the IP address.

For example, on a UNIX system, enter “telnet </P_address> 6472”. This
connection will give you access to the emulator’s built-in terminal interface.
You should see a prompt, such as “M>".

At the prompt, type:

ver

You should then see information about the emulator and firmware version.

To exit from this telnet session, type <CTRL>D at the prompt.

The online help or manual for your logic analysis system, for information on
physically connecting the system to the LAN and configuring LAN parameters.

If you have problems verifying LAN communication, see page 129.
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Example

To export the logic analysis system’s display to
a workstation

By exporting the logic analyzer’s display, you can see and use the logic analysis
system’s windows on the screen of your workstation. To do this, you must have
telnet software and X window installed on your computer.

On the workstation, add the host name of the logic analysis system to
the list of systems allowed to make connections:

xhost +</P_address>

Use telnet to connect to the logic analysis system.

tel net </ P_address>

Log in as “hplogic”.

The logic analysis system will open a Session Manager window on your display.

In the Session Manager window, click Start Session on This Display.

On a UNIX workstation, you could use the following commands to export the
display of a logic analysis system named “mylogic”:

$ xhost +nyl ogic

$ telnet nylogic

Trying. ..

Connected to myl ogi c. myconpany. com
Escape character is ‘.

Local flow control on

Telnet TERMINAL-SPEED option ON

Agilent Technologies Logic Analysis System
Please Log in as: hplogic [displayname:0]

login: hplogic
Connection closed by foreign host.
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To export the logic analysis system’s display to
a PC

By exporting the logic analyzer’s display, you can see and use the logic analysis
system’s windows on the screen of your PC. To do this, you must have telnet
software and an X terminal emulator installed on your computer. The
following instructions use the Reflection X emulator from WRQ, running on
Windows 95, as an example.

1 On the PC, start the X terminal emulator software.

To start Reflection X, click the Reflection X Client Startup icon.
2 Start a telnet connection to the logic analysis system.

Log in as “hplogic”.

For Reflection X, enter the following values in the Reflection X Client Startup
dialog:

a In the Host field, enter the LAN name or IP address of the logic
analysis system.

b In the User Name field, enter “hplogic”.
¢ Leave the Password field blank.

d Leave the Command field blank.

e Click Run to start the connection.

The logic analysis system will open a Session Manager window on your display.

3 In the Session Manager window, click Start Session on This Display.
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Using the ARM Debugger for Windows

Compatibility

The ARM Debugger for Windows (ADW) and ARM Developer Suite
v1.0 or greater are two of the debuggers that connect to the Agilent
Technologies emulator. ADW is part of the Software Development
Toolkit (SDT), available from ARM Ltd. Only versions of the SDT
greater than v2.11a support the use of an Agilent Technologies
emulator.

This section provides information that is specific to using ADW with
the emulator. It should be used in conjunction with the more detailed
SDT user documentation provided by ARM. In the case of any conflict
between these two sources, the SDT documentation should be
considered definitive.

Overview

Host Computer LAN Emulation
probe or Logic
ADW | sl Analysis - Target
System with
probe module
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Getting Started

Connect and set up the emulation probe or logic analysis system
as described in the Agilent Technologies documentation.

Ensure that the file ‘gateway.dll’ is placed in the ‘bin’ sub-directory of
the ADW installation directory. Depending on the intended target
system, one or more Gateway Configuration ‘.gcf’ files should also be
placed in this same directory. The relationship between target and
configuration file is given in the following table:

Target File
ARM 7TTDMI gate_arm7tdmi.gcf
ARM 710T gate_arm710t.gcf
ARM 720T gate_arm720t.gcf
ARM 740T gate_arm740t.gcf
ARM 920T gate_arm920t.gcf
ARM 940T gate_arm940t.gcf
ARM 966ES gate_arm966es.gcf

The list given in this table may not be exhaustive.

Configure the ARM Debugger for Windows.

The ARM Debugger for Windows must be configured prior to use with
the emulator.

a Start ADW and allow it to initialize normally.

If no errors occur, choose Options->Configure Debugger from the
ADW menu to display the configuration dialog for ADW.

If an initialization error does occur, then choose Cancel and enter
Armulator mode (SDT versions prior to v2.50) then choose Options-
>Configure Debugger again, or simply click on the Configure
button when this is presented as an option (SDT v2.50 and higher).

96



Using the Emulator with a Debugger
Using the ARM Debugger for Windows

The configuration dialog actually consists of a number of tabbed pages, a
particular page being chosen by clicking on the corresponding tab. Select
the Target tab of the dialog.

Select gateway.

If gateway has been used previously, then click on the target environment
combo box to display the list of known environments and ensure that
gateway is selected.

If a version of gateway has not been installed previously, it must be added
to the list of target environments supported by ADW. Do so by clicking on
the Add button on the dialog and then opening the gateway.dll file. This
automatically makes gateway the selected environment.

Configure gateway.

Click on the Configure button to display the configuration parameters
specific to gateway. These include the currently used network location of
the emulation probe, the target processor type, and a list of channel
viewers. Selecting a channel viewer involves checking the Enabled
checkbox and highlighting the particular viewer in the list. There are also
Add and Remove buttons to enable the list to be manipulated. Please see
the relevant ARM documentation for details of channel viewers and their
usage.

Click on the Set button to alter the network location and target type
parameters. A further dialog is then displayed where the new address can
be entered and a target selected from those supported by the emulation
probe. Note that there may be a short delay before display of this dialog as
a connection is made to the emulation probe.

Click OK to dismiss the gateway configuration dialog. Change parameters
listed on other pages of the configuration dialog as appropriate. In
particular, make sure that the target endianess is set up correctly on the
Debugger page. Finally click OK again to dismiss the ADW configuration
dialog. ADW should restart without errors using the new configuration.
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To Perform Common Debugger Tasks

To download an image, choose File->Load Image from the ADW
command menu. The Load Image file dialog is displayed and can be
used to locate and select the image file. During a download the number
of bytes written and read is displayed as a progress indicator. Once the
operation is complete, the execution window of ADW will show the
start of the disassembled code. If the image contains debug information
and has been compiled from ’C’ sources a breakpoint is automatically
inserted by ADW at the start of the main() procedure.

To start execution of a downloaded image, choose Execute-
>Go from the ADW menu. Note that the initial value of the PC will have
been set appropriately as a result of the download.

To stop the target, choose Execute->Stop from the ADW menu. A
subsequent Execute->Go will start the target running from the
current value of the PC.

To set or clear a breakpoint, select the line in the execution
window and choose Execute->Toggle Breakpoint. If no breakpoint
exists at this location it is added, while an existing breakpoint will be
cleared. This can only be done while the target is stopped.

To set a watchpoint, select View->Variables and choose either
local or global. This displays respectively the variables that are local to
the current procedure or global within the application. Selecting the
value of interest and choosing Execute->Toggle Watchpoint sets the
watchpoint.

To display or modify registers, choose View->Registers and
select the desired register bank (that is, the set of registers for a
particular ARM processor mode). All of the registers in that bank are
then displayed in a separate window. To change the value of a register,
double-click on the displayed value in this window. A further dialog box
is then displayed from which a new value for that register can be set.
These operations can only be carried out when the target is stopped.

To step through code, choose Execute->Step. Various other
stepping options are also available from the execute menu such as Step
In, Step Out and Run to Cursor.
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Note that the above operations can be carried out in a variety of other
ways, for example shortcut keys or toolbar buttons. See ARM
documentation for further details.

Error Conditions

The emulator can detect and report to ADW that the target power is
switched off. However, if the emulator is not connected or powered
down, ADW will appear to hang for approximately 1 minute during
start-up. This is simply a network time-out. ADW will then report that
it could not initialize the communications link. Under these
circumstances, check all connections and ensure that the address of
the emulator has been correctly specified. The behavior is similar if the
TIM has been disconnected from the emulator. In this case, the error
reported will be failure to enter monitor mode.

Starting up ADW after the target has been power cycled may result in
repeated warnings that the probe cannot read memory. This is not a
problem and occurs as a result of the debugger attempting to access
memory around a non-valid value in the pc register. The debugger’s
execution window may be all or partially blank as a result of these
errors.

If certain sensitive operations, such as downloading memory, are
interrupted, subsequent attempts to start up ADW may result in an
error message stating that the probe could not enter monitor mode.
Under these circumstances it may be necessary to cycle power to the
probe and target.

The ARM Web Site: http:/www.arm.com

The Software Development Toolkit User Guide.
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Processor compatibility

The Agilent Technologies emulation probe supports the following processors:

e ARM7TDMI
e ARM7DI

e ARM710T

e ARM720T

e ARM740T

e ARM920T

e ARMY940T

e ARMY66ES

The emulation probe supports a target voltage reference from 1.2V to 5V.
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Emulation probe and emulation module—

electrical characteristics

Maximum Ratings

Characteristics for Agilent

Technologies Emulation Probe S Hin Dlax
TDO,DBGACK Vi 0.8x Vce

Vi 0.2x Vcc

I 1A

Cin 15 pF
TDI,TCK,TMS,TRST,DBGRQ Voh@loh=-32 mA 0.8x Vce

Vo @l ,n=64 mA; V=45V 0.2xVcc
TDI,TMS, TRST,.DBGRQ C, 25 pF
TCK Co 45 pF
Viref! Vin 12V 5V

Vi 08V
SRST2 Vo @24mA 05V

Co 25 pF

Viref is used only to determine target powered status. The emulation
probe does not draw power from this source.

2 Open collector output, pulled up to a generated voltage equivalent to the Vtref voltage with a2.61 K

pullup resistor.
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Emulation probe—electrical characteristics

BNC, labeled TRIGGER OUT

Output Drive. 2.0 V. Logic low level with 50-ohm load <= 0.4 V. Output
function is selectable, see the configuration chapter (page 63).

BNC, labeled BREAK IN

Input. Edge-triggered TTL level input, 20 pF, with 2k ohms to ground in
parallel. Maximum input: 5V above VCC; 5 V below ground. Input function is
selectable, see the configuration chapter (page 63).

Communications

Serial Port. 9-pin female type D subminiature connector. RS-232 DCE to
115.2 kbaud.

10BASE-T LAN Port. RJ-45 connector. IEEE 802.3 10BASE-T
(StarLAN).

10BASE 2 LAN Port. 50-ohm BNC connector. IEEE 802.3 10BASE2
(ThinLAN). When using this connector, the Agilent Technologies emulator
provides the functional equivalent of a Medium Attachment Unit (MAU) for
ThinLAN.

Accessory Power Out

12V, 3.0A, center negative
Power Supply

Input. 100-240V, 9.75 A, 50/60 Hz, IEC 320 connector.

Output. 12V,3.3 A
CAT I (Mains isolated)
Pollution degree 2

104



Specifications and Characteristics

Emulation probe—environmental

characteristics

Temperature Operating, +5 C to +40 C (+41 to +104 F); nonoperating, -40 to +70 C (-40 to
+158 F).

Altitude Operating/nonoperating 4600 m (15 000 ft).

Relative Humidity 15% to 95%.

Emulation module—environmental
characteristics

The Agilent Technologies 16610A emulation module meets the environmental
characteristics of the logic analysis system in which it is installed.

For indoor use only.
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Updating Firmware

Firmware gives your emulator a “personality” for a particular processor or
processor family.

After you have connected the emulator to your target system, you may need to
update the firmware to give it the right personality for your processor.

You must update the firmware if:

e You have an emulation module which was not shipped already installed in
the logic analysis system.

e You need to change the personality of the emulator for a new processor.

e You have an updated version of the firmware from Agilent Technologies.

The procedure for updating firmware for an emulation probe is different from
the procedure for updating firmware for an emulation module.
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Emulation Probe Firmware

To display current firmware version
information

Use t el net or a terminal emulator to access the built-in "terminal
interface" and use the ver command to view the version information
for firmware currently in the emulation probe.

To update firmware for an emulation probe

To update the firmware, you must have access to the World Wide Web and a
PC or a workstation connected to your emulation probe.

Download the new firmware from the following World Wide Web site:

http://ww. agil ent. coni find/ enul at or
The firmware will be in the “Technical Support Information” section of this
web site.

Follow the instructions on the web site for installing the firmware.

If Agilent Technologies sends you firmware on a floppy disk, install the
firmware from the floppy disk. The README file on the floppy disk contains
instructions for installing the firmware using a PC or workstation.
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Emulation Module Firmware

Always update firmware by installing a processor support package. This will
ensure that the version of the Emulation Control Interface software is
compatible the version of the emulator firmware.

To display current firmware version
information

In the Update Firmware window, click Display Current Version.

There are usually two firmware version numbers: one for “Generics” and
one for the personality of your processor.

To update firmware for an emulation module
using the Emulation Control Interface

End any run control sessions which may be running.

In the Workspace window, remove any Emulator icons from the
workspace.

Install the processor support package from the CD-ROM, if necessary.
In the system window, click the emulation module and select

Update Firmware.

Slot 1
HF Emulation Module

Start Session...

" Update Firmware,,.

Ferformance Yerification...

Help. ..

In the Update Firmware window, select the firmware to load into the
emulation module.
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Updating Firmware
Emulation Module Firmware

6 Click Update Firmware.

In about 20 seconds, the firmware will be installed and the screen will update
to show the current firmware version.

“Installing Software” beginning on page 52 for instructions on how to install
the processor support package from the CD-ROM.

See also

To update firmware for an emulation module
using the Setup Assistant

The Setup Assistant is an online tool for connecting and configuring your logic
analysis system for microprocessor and bus analysis. The Setup Assistant is
available on the Agilent Technologies 16600A and 16700A-series logic analysis
systems.

This menu-driven tool will guide you through the connection procedures for
connecting the logic analyzer to an analysis probe, an emulation module, or
other supported equipment. It will also guide you through connecting an
analysis probe to the target system.

Install the processor support package from the CD-ROM.

Start the Setup Assistant by clicking its icon in the system window.

Follow the instructions displayed by the Setup Assistant.

Page 53 for instructions on how to install a the processor support package
from the CD-ROM.
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Solving Problems

If you have problems with the emulator, your first task is to determine the
source of the problem. Problems may originate in any of the following places:

e The connection between the emulator and your workstation, PC, or logic
analyzer

e The emulator itself

¢ The connection between the emulator and the target interface module

e The connection between the target interface module and the target system

e The target system
You can use several means to determine the source of the problem:

¢ The troubleshooting guide on the next page

e The status lights on the emulator

e The emulator "performance verification" tests

e The emulator’s built-in "terminal interface" commands
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Troubleshooting Guide

For troubleshooting the emulation module, refer to the online help in the logic
analysis system.

Common problems and what to do about them (Emulation probe)

Symptom Action Page
Host computer reports LAN Follow the checklistin the “If you have LAN problems” Page 129
connection problems section.

Commands from the Emulation 1 Verify LAN communication. Page 38

Control Interface or debugger 2 Check that you are using the correct firmware for your Page 110
have no effect chip.
3 Use a telnet connection (or serial connection) to try a Page 118
few built-in commands. If this works, your debugger may
not be configured properly. If this does not work, continue
with the next procedure...

Emulator built-in commands do 1 Check that the emulator has been properly configured Page 63

not work for your target system.
2 Run the emulator performance verification tests. Page 137
3 If the performance verification tests pass, then there is
an electrical problem with the connection to the target Page 83

processor OR the target system may not have been
designed according to “Designing a Target System.”

“Slow or missing clock” Check that the target system is running user code or is in

message after a logic analyzer reset. (This message can appear if the processoris in

run background mode.)

"Slow clock" message in the Check that the clock rate is properly configured. page 72

Emulation Control Interface or
“¢>" promptin the built-in
“terminal interface”

Some commands fail Check the “restrict to real-time runs” configuration Page 71
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Emulation Probe Status Lights

The emulation probe communicates various modes and error conditions via
the status lights.

The following table gives information about the meaning of the power and
target status lights.

0 = LED is off
e = LED is on
[0 = Not applicable (LED is off or on)

Power/Target Status Lights

Pwr/Target LEDs Meaning

00 Emulation probe is not connected to power supply
od

Oe No target system power, or emulator is not connected to the
oo target system

Oe Target system is in a reset state

Oe

oo Only boot firmware is good (other firmware has been
o[l corrupted)

oo The target processor is in debug mode

od

Oe The target processor is executing user code

o[]

oo The target processor is in an unknown state

L X J
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Emulation probe status lights

The following illustration shows the status lights on both sides of the
emulation probe and what they mean:

Lit when the power suply is properly
connected to the emulation probe

Lit when the target processor is
running in debug mode

/ Lit when the target system is in a
reset state

23496e09

Lit when the target processor is
running in normal (user program)
mode

Lit when LAN data is being transmitted

Lit when 10BASE-T connection has a
good link; not used for 10BASE2

Lit when the polarity on the receive E3450E06 Lit when LAN data is being
twisted pair is reversed for a 10BASE-T received
connection

Status Lights
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Emulation Module Status Lights

The emulation module communicates various modes and error conditions via
the status lights.

The following table gives information about the meaning of the power and
target status lights.

0 = LED is off
e = LED is on
[0 = Not applicable (LED is off or on)

Power/Target Status Lights

Pwr/Target LEDs Meaning

0 Reset No target system power, or emulation module is not
O Break connected to the target system

O Run

e Reset Target system is in a reset state

O Break

O Run

0 Reset The target processor is executing in Debug Mode
e Break

O Run

0 Reset The target processor is executing user code

O Br eak

e Run

0 Reset Only boot firmware is good (other firmware has been
e Break corrupted)

e Run

Built-in Commands

The emulator has some built-in "terminal interface" commands which you can
use for troubleshooting.
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You can access the terminal interface via:

e A serial connection (Emulation probe only. See page 40.)

e A telnet (LAN) connection

e The Command Line window in the Emulation Control Interface
e A '"debugger command" window in your debugger

Here are a few useful commands:

Useful built-in commands

Commands Meaning

b Break—go into debug mode

cf Configuration—read or write configuration options

help Help—display online help for built-in commands

init Initialize—init-c reinitializes everything in the emulator except for the LAN software;
init-p is the equivalent of cycling power (it will break LAN connections)

lan configure LAN address

m Memory—read or write memory

reg Register—read or write register

r Run—start running user code

rep Repeat—repeat a command or group of commands

rst Reset—reset the target processor

3 Step—do a low-level single step

ver Version—display the product number and firmware version of the emulator
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The prompt indicates the status of the emulator:

Emulator prompts

Prompts Meaning

R Emulation reset

U Running user program

M Running in background monitor
r Target system reset active

p No target power

? Unknown state

Examples

To set register RO, then view RO to verify that it was set, enter:

R>rst -m
Mereg rO=ffff
Mereg rO

reg RO=0000ffff

To break execution then step a single instruction, enter:

M>b
M>s
PC=XXXXXXXX
M>
To determine what firmware version is installed in the emulation
module, enter:

M>ver

See Also Use the hel p command for more information on these and other commands.
Note that some of commands listed in the help screens may not be available.

If you are writing your own debugger, contact Agilent Technologies for more
information.
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Problems with the Target System

What to check first

Try some basic built-in commands (using a serial or telnet connection):

U>r st
R>

This should reset the target and display an "R>" prompt.

R>b
M>

This should stop the target and display an "M>" prompt.

Mreg rl
reg r1=007f d6a0
M
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This should read the value of the rl register (the value will probably be
different on your target system).

M>m 0. .
00000000 7c3043a6 7c¢2802a6 7c3143a6 4bf04111
00000010 00000000 00000000 00000000 00000000
00000020 00000000 00000000 00000000 00000000
00000030 00000000 00000000 00000000 00000000
00000040 00000000 00000000 00000000 00000000
00000050 00000000 00000000 00000000 00000000
00000060 00000000 00000000 00000000 00000000
00000070 00000000 00000000 00000000 00000000

M>

This should display memory values starting at address 0.
M>s

This should execute one instruction at the current program counter.

Note that stepping can fail if memory at the current PC does not contain a valid
instruction.

If any of these commands don’t work, there may be a problem with the design
of your target system, a problem with the revision of the processor you are
using, or a problem with the configuration of the emulator. The following steps
will help you identify the problem.

Check that the emulator firmware matches your processor. To do this,
enter:

Msver

Page 118 for information on entering built-in commands.
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To check the debug port connector signals

e (Check for the following logic levels on the target debug port. The signal
names are for the ARMTY.

Signal Levels with the emulation probe in default’ reset state

Signal Name  ARM 14-pin VLS 14-pin T1 14-pin :)‘i':M/Ag"e"t Level
Vee/Viref/SPU 1,13 13 5 1 1.2V - 5.0V2
TDI 5 5 3 5 Toggling
TDO 11 11 7 13 Toggling
TCK 9 9 11 9 ~10MHz signal
™S 7 7 1 7 Toggling
nSYSRST 12 12 N/A 15 Low
DBGACK N/A N/A N/A 19 Low
DBGREQ N/A N/A N/A 17 Low
nTRST 3 3 2 3 High

PT N/A 10 N/A N/A High
PN{3:0} N/A 4,6,8 N/A N/A Low

All other pins should be low.

Default cf settings

2Target dependent
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To interpret the initial prompt

The initial prompt can be used to diagnose several common problems.
Connect the emulator to your target system.

Set the default configuration settings. Enter:

Meinit -c

You can enter this command at any prompt. The emulator will respond with
the same information as printed by the "ver" command.

If the response is ""ERROR 905! Driver firmware is
incompatible with ID of attached device"

Make sure the target interface module is connected to the cable of the
emulator, then try the "init -¢" command again.

If the initial prompt is "p>"

Check pin 1 on header (if using the TI connector check pin 5 instead) 1.2V -
5V (VDD).

If the initial prompt is "M>"

The processor entered debug mode without the help of the emulator. Is
another debugger connected?

If the initial prompt is "?>"

Check TCK, TDO, TDI, TMS, and TRST_L signals. Check the firmware
revision.
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If the initial prompt is "R>"

The emulator is scanning the JTAG correctly. Now you can do some more
tests:

Enter the reset command:

R>r st
R>

The "R>" prompt is a good response that indicates that nRESET is working.
Continue with "If the prompt after rst is R>".

Enter the break command:

R>b
M-

If the prompt after b is "U>" with error messages

If you see: ""ERROR 608! Unable to break”, try resetting the target
and/or cycling power on the target.

If the problem still persists, then try the sequence:

U>rst
R>r
M>Db

Some ARM chips have problems if JTAG commands are issued while the chip
is reset. Using the “rst”, “r”, “b” sequence avoids this problem.

If the prompt after b is "M>" with no error messages

Everything is still working correctly. Continue with more tests:
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If you can get to the "M>" prompt
5 At the "M>" prompt , check register and memory access:

Mereg r0

reg rO=xxXXxXXXxx
M>reg r0=12345678
Mereg r0

reg r0=12345678
M

If the returned value is equal to the written value, then the voltage level of the
chip is probably correct.

Now enter:

Mem -d4 -a4 0=11111111, 22222222, 33333333, 44444444

M>m -d4 -a4 0.
00000000 11111111 22222222 33333333 44444444
00000010 00000000 00000000 00000000 00000000
00000020 00000000 00000000 00000000 00000000
00000030 00000000 00000000 00000000 00000000
00000040 00000000 00000000 00000000 00000000
00000050 00000000 00000000 00000000 00000000
00000060 00000000 00000000 00000000 00000000
00000070 00000000 00000000 00000000 00000000

M>

e Returned value is equal to the written value implies that memory is
working.

e Returned value is not equal to the written value implies that the memory
controller may not be initialized. Be sure the memory controller for your
target is setup correctly.
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If you see memory-related problems

1 Set caches and translation off. Refer to your target documentation for
doing this.

2 Now enter:

Mem -d4 -a4 0=11111111, 22222222, 33333333, 44444444

M>m -d4 -a4 0.
00000000 11111111 02222222 33333333 44444444
00000010 00000000 00000000 00000000 00000000
00000020 00000000 00000000 00000000 00000000
00000030 00000000 00000000 00000000 00000000
00000040 00000000 00000000 00000000 00000000
00000050 00000000 00000000 00000000 00000000
00000060 00000000 00000000 00000000 00000000
00000070 00000000 00000000 00000000 00000000

e Read value not equal to the written value implies that the memory
controller is not setup correctly.

e Read value equal to the written value implies that the emulator firmware
might not be working with cache.

3 Hand load a little program:

M>m -d4 -a4 100=e2811001, 00000000, 60000000, eaf ffffc
M>reg r1=0
M

This means: Add rl, r1, #1, NOP, b 100
Set the PC to this program:

M>reg pc=100
M

Step, then check the register:

M>s

pc=00000104
Mreg rl

reg r1=0000 0001
M

This should return'"reg r1=00000001" .
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Step some more and verify that r1 increments after every three steps:

M>s 3

pc=00000104
Mreg rl

reg r1=00000002
M

If this does not work as described, make sure “cf endian” is set correctly for
your target, the memory at 100 is read/write memory, and that the memory
controller is programmed correctly.
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NOTE:

Problems with the LAN Interface (Probe Only)

For LAN interface problems with the emulation module, refer to the online
help in the logic analysis system.

If you cannot verify LAN communication

If you cannot verify connection using the procedure in "To verify LAN
communication", or if the commands are not accepted by the emulation probe:

O

Make sure that you have connected the emulation probe to the proper
power source and that the power light is lit.

Make sure that you wait for the power-on self test to complete before
connecting.

Make sure that the LAN cable is connected. Watch the LAN LED’s to see
whether the emulation probe is seeing LAN activity.Refer to your LAN
documentation for testing connectivity.

Make sure that only one of the LAN ports is connected.

Make sure the emulation probe communication configuration switches are
set correctly. Unplug the emulation probe power cord, then plug it in again
to make sure the switch settings are read correctly by the emulation probe.

Check that the Emulation Control Interface or debugger was configured
with the correct LAN address. If the emulation probe is on a different
subnet than the host computer, check that the gateway address is correct.

Make sure that the emulation probe’s IP address is set up correctly. Use
the RS-232 port to verify this that the IP address is set up correctly. When
you are connected to the RS-232 port, run performance verification on the
emulation probe’s LAN interface with the "pv" command.

It’s also possible for there to be a problem with the emulation probe
firmware while the LAN interface is still up and running. In this case, you
must reboot the emulation probe by disconnecting power to the emulation
probe and reconnecting it again.
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[0 Use a serial connection to run the LAN performance verification tests (see
page 137).

If you have LAN connection problems

[0 If the emulation probe does not accept commands from the
Agilent Technologies 16600A/700A:
1. Check that switch S1 is "0" (attached to LAN, not RS-232).
2. Check that switch S5 is in the correct position for your LAN interface
(either 10BASEZ2 or 10BASE-T).
(Remember: if you change any switch settings, the changes do not take
effect until you cycle power.)

0 If the emulation probe still does not respond, you need to verify the IP
address and gateway mask of the emulation probe. To do this, connect the
emulation probe to a terminal or terminal emulator (see page 40), change
the switch settings so it is connected to RS-232, and enter the "lan"
command. The output looks something like this:

lan -i 15.5.24.116

lan -g 15.5.23.1

lan -p 6470

Et hernet Address : 08000909BAC1

"lan -i" shows the internet address is 15.5.24.116 in this case. If the Internet
address (IP) is not what you expect, you can change it with the ’lan -i >’
command.

"lan -g" shows the gateway address. Make sure it is the address of your
gateway if you are connecting from another subnet, or 0.0.0.0 if you are
connecting from the local subnet.

"lan -p" shows the port is 6470.

If the "POL" LED is lit

The "POL" LED indicates that the polarity is reversed on the receive pair if
you are using a 10BASE-T connection. The emulator should still work
properly in this situation, but other LAN devices may not work.
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If it takes a long time to connect to the network

[0 Check the subnet masks on the other LAN devices connected to your
network. All of the devices should be configured to use the same subnet
mask.

Subnet mask error messages do not indicate a major problem. You can
continue using the emulation probe.

The emulation probe automatically sets its subnet mask based on the first
subnet mask it detects on the network. If it then detects other subnet masks,
it will generate error messages.

If there are many subnet masks in use on the local subnet, the emulation
probe may take a very long time to connect to the network after it is turned
on.

To "clean up" the network, connect a terminal to the emulation porbe. You can
then see error messages which will help you identify which devices on the
network are using the wrong subnet masks.
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Problems with the Serial Interface (Emulation
probe only)

If you cannot verify RS-232 communication

If the emulation probe prompt does not appear in the terminal emulator
window:

[0 Make sure that you have connected the emulation probe to the proper
power source and that the power light is lit.

0 Make sure that you have properly configured the data communications
switches on the emulation probe and the data communications parameters
on the host computer. You should also verify that you are using the correct
cable.

The most common type of data communications configuration problem
involves the configuration of the emulator as a DTE device instead of as a DCE
device. If you are using the wrong type of cable, no prompt will be displayed.

A cable with one-to-one connections will work with a PC or an HP 9000 Series
700 workstation.
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If you have RS-232 connection problems with
the MS Windows Terminal program

0 Remember that Windows 3.1 only allows two active RS-232 connections at
a time. To be warned when you violate this restriction, choose Always Warn
in the Device Contention group box under 386 Enhanced in the Control
Panel.

[0 Use the "Terminal" program (usually found in the Accessories windows
program group) and set up the "Communications..." settings as follows:

Baud Rate: 9600 (or whatever you have chosen for the
enul ati on probe)

Data Bits: 8

Parity: None F

| ow Control: hardware

Stop Bits: 1

When you are connected, hit the Enter key. You should get a prompt back. If
nothing echos back, check the switch settings on the emulation probe.

O If the switches are in the correct position and you still do not get a prompt
when you hit return, try turning OFF the power to the emulation probe
and turning it ON again.

O Ifyou still don’t get a prompt, make sure the RS-232 cable is connected to
the correct port on your PC, and that the cable is appropriate for
connecting the PC to a DCE device.

With certain RS-232 cards, connecting to an RS-232 port where the emulation
probe is turned OFF (or is not connected) will hang the PC. The only way to
get control back is to reboot the PC. Therefore, we recommend that you
always turn ON the emulation probe before attempting to connect via RS-232.
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Problems with the Emulation Probe Itself

To run the power up self test

1 Unplug the emulation probe, then plug it in.

2 Watch the status lights. They should show the following pattern:
0 = LED is off
e =LED ison
[0 = Not applicable (LED is off or on)

Normal sequence during power up self test

Pwr/Target .
LEDs Meaning

1 Oe Initial power up, system reset
oo

2 Oe XILINX array initialized successfully
oo

3 Oe XILINX array tested successfully
o []

4 oo BOOT ROM space tested successfully
aod

5 Oe GENERIC ROM space tested successfully
o []

6 oo DRIVER ROM space tested successfully
oo

7 Oe RESERVED ROM space tested successfully
o []

8 oo RAM tested successfully
oo

9 Oe LAN internal feedback tested successfully
o []

10 Oe Boundary scan master (BSM) test begun
aod

1" oo BMS test completed, start system, load drivers, initialize
o[l LAN
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If the power up self test fails, the RESET LED will flash the number of the
test, then stay lit.

If any of the LEDs fail to change, or all of them remain on, there is a system
failure.
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Following power up, the LEDs will enter one of the following states:

Pwr/Target .

LEDs Meaning

Oe No target system power, or the emulation probe is not connected to
oo the target system, or remove

Oe Target system is in a reset state

Oe

Oe Target processor is executing user code

o []

oo Target processor is in an unknown state

LN J

oo Target processor is in debug mode

oo

oo Only the boot ROM was used; other firmware in the Flash EPROM
o[l has been corrupted

Starting a user interface will change the pattern to the one requested by the

interface.

If the power up self tests fail, try the following;:

0 Check and reset the LAN address. LAN powerup failures will occur if the
emulation probe does not have a valid Link Level Address and IP Address.

0 Disconnect all external connections, including the LAN, serial (RS-232),
and BNC Break and Trigger cables, then cycle power.

0 To ensure that the firmware is working as it should, reprogram the
firmware, then cycle power.
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To execute the built-in performance

verification tests

In addition to the powerup tests, there are several additional performance
verification (PV) tests available.

Some of these tests can be performed through the 16700A/700A. The LAN
tests for an emulation probe can only be executed through the RS-232 port.

To fully test the emulation probe, you will need to run the PV test with several
hardware configurations:

e For the BREAK IN, TRIGGER OUT BNC FEEDBACK TEST, connect a
coaxial cable between BREAK IN and TRIGGER OUT.

To run the built-in performance verification test using the
logic analysis system

End any Emulation Control Interface or debugger sessions.

Disconnect the 50-pin cable from the emulation module, and plug
the loopback test board (Agilent part number E3496-66502) into
the emulation module.

In the system window, click the emulation module and select
Performance Verification.

Click Start PV.

The results will appear onscreen.
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See Also

To perform complete PV tests for an emulation
probe

The LAN tests can only be executed through the RS-232 port. The remainder
of this section assumes that the tests are being run from a terminal emulator
connected to the RS-232 port.

Disconnect the 50-pin cable from the emulation probe, and plug the
emulator loopback test board (Agilent part number E3496-66502)
directly into the emulator. Do not plug anything into the other end of
the emulator loopback test board.

On a good system, the RESET LED will light and the BKG and USER LEDs will
be out.

Connect a coaxial cable between BREAK IN and TRIGGER OUT.
Set all of the switches to CLOSED.

This is standard RS-232 at 9600 baud which can be connected directly to a 9
pin RS-232 interface that conforms to the IBM PC-AT 9 pin standard.

Use a terminal emulator to connect to the emulation probe.

Enter the pv 1 command.

Options available for the "pv"' command are explained in the help screen
displayed by typing "help pv" or "? pv" at the prompt.
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Examples
Here are some examples of ways to use the pv command.
To execute both tests one time:

pv 1

To execute test 2 with maximum debug output repeatedly until a
AC is entered:

pv -t2 -v9 0O
To execute tests 3, 4, and 5 only for 2 cycles:
pv -t3-5 2

The results on a good system, with the BNC’s connected, and with
the loopback test board connected, are as follows:
c>pv 1

Testing: E3499B Series Enul ati on Syst enpassed!
Test # 1: Powerup PV Resul tspassed!

Test # 2: LAN 10Base2 Feedback Testpassed!
Test # 3: LAN 10BaseT Feedback Testpassed!
Test # 4: Break In and Trigger Qut BNC Feedback Test passed!
Test # 5: Target Probe Feedback Test passed!
Test # 6: Boundary Scan Master Testpassed!
Test # 7: 12C Test passed!
Test # 8: Data Lines Testpassed!
PASSED Number of tests: 1Number of failures: 0

Copyright (c) Agilent Technol ogi es 1987
Al R ghts Reserved. Reproduction, adaptation, or translation wthout
prior witten perm ssion is prohibited, except as all owed under copyri ght
| aws.

E3499B Series Enul ati on System
Ver si on: A.07.56 28Sept 98
Location: Generics

E3459A ARMZ JTAG Enul at or
Ver si on: A.01. 50 13Cct 98
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R>pv -t2 -v2 1

If a performance verification test fails

There are some things you can do if a failure is found on one of these tests.
Details of the failure can be obtained through using a verbose level of 2 or
more.

If the particular failure you see is not listed below, contact Agilent Technologies for
assistance.

TEST 2: LAN 10BASE2 Feedback Test failed

For LAN 10BASEZ2 test, the following is an example of a failure which is not
caused by a broken emulator.

Testing: E3499B Series Emul ati on System

Test # 2:

LAN 10Base2 Feedback Test fail ed!

FAILED - no lan connection (LAN probably not terninated
FAI LED Number of tests: 1 Nunber of failures: 1

R>pv -t2 -v2 1

Check to see that the port under test has a good cable connected to it and that
the cable is properly terminated with a 50 ohm terminator on each end of the
overall cable.

Testing: E3499B Series Enul ation System

Test # 2:
FAI LED
FAI LED Nunber

R>pv -t2 -v2 1

LAN 10Base2 Feedback Test failed!
due to excessive collisions
of tests: 1Nunmber of failures: 1

The most common cause of this problem is poor termination of the cable or
failure to remove the port under test from the LAN before performing the test.
Check to see that the terminators are good (50 Ohms) and that you are
isolated from any traffic on a system LAN.

Testing: E3499B Series Enul ation System

Test # 2:
FAI LED
FAI LED Nunber

LAN 10Base2 Feedback Testfail ed!
- invalid Ethernet address in EEPROM
of tests: 1 Nunber of failures: 1

First check to see that a correct LLA and IP address have been set in the
virtual EEPROM through the "lan" command. If the "lan" command shows bad
information for the LLA and IP, then try to set them to correct values. If you
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are unable to set them to correct values, their is a failure in the FLASH ROM
which requires service from Agilent Technologies.

Test 3: 10BaseT Feedback Test failed here

Testing: E3499B Series Enul ation System

Test # 3:
FAI LED Nunber

R>pv -t4 -v2 1

LAN 10BaseT Feedback Test fail ed!

of tests: 1 Nunber of failures: 1

In addition to the internal checks performed in Test 2, this test also checks for
shorts on the cable connected to the network. If this test fails, disconnect the
cable and run the test again. If it then passes, the cable is faulty. If it still fails,
it requires service from Agilent Technologies.

If the emulator passes this "pv" test, additional testing can be performed
through exercising the connection to the network. To run this test, set
configuration switch 1 and switch 5 to OPEN, all other configuration switches
CLOSED (this enables LAN using 10BaseT). Cycle power and wait for 15 to 30
seconds. Then "ping" the emulator from your host computer or PC. See the
LAN documentation for your host computer for the location and action of the
"ping" utility. If the emulator fails to respond to the "ping" request, verify that
the lan parameters (IP address and gateway address) are set correctly and
that your host computer recognizes the IP address of the emulator. If all else is
good, then failure to respond to ping indicates a faulty emulator.

Test 4: Break In and Trigger Out BNC Feedback Test

Testing: E3499B Series Enul ation System
Test # 4: Break In and Trigger Out BNC Feedback Testfail ed!
Break In not receiving Break Qut HI GH

FAI LED Nunber

of tests: 1 Nunber of failures: 1

Before returning to Agilent Technologies, check to ensure that you have
connected a good Coaxial cable between the two BNCs. If the cable is good,
the emulator is bad.
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TEST 5: Target Probe Feedback Test
TEST 6: Boundary Scan Master Test
TEST 7: 12C Test

TEST 8: Data Line Test

If these tests are not executed, check that you have connected the emulator
loopback test board.

If these tests fail, return the emulator to Agilent Technologies for
replacement.
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Returning the Parts to Agilent Technologies for
Service

To return a part to Agilent Technologies

Follow the procedures in this chapter to make sure that the problem is
caused by a failure in the emulator or power supply, not by
configuration or communication problems.

In the U.S., call 1-800-403-0801. Outside the U.S., call your nearest
Agilent Technologies sales office. Ask them for the address of the
nearest Agilent Technologies service center.

A list of Agilent Technologies sales offices is included at the back of this
manual.

Package the part and send it to the Agilent Technologies service
center.

Keep any parts which you know are working. For example, if only the power
supply is broken, keep the target interface module, emulator and cables.

When the part has been replaced, it will be sent back to you.

The unit returned to you will have the same serial number as the unit you sent
to Agilent Technologies.

The Agilent Technologies service center can also troubleshoot the hardware
and replace the failed part. To do this, send your entire measurement system
to the service center, including the logic analysis system, target interface
module, and cables.

In some parts of the world, on-site repair service is available. Ask an Agilent
Technologies sales or service representative for details.
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To obtain replacement parts

The repair strategy for this emulation solution is board replacement. The
following table lists some parts that may be replaced if they are damaged or
lost. Contact your nearest Agilent Technologies Sales Office for further
information on servicing the board.

Exchange assemblies are available when a repairable assembly is returned to
Agilent Technologies. These assemblies have been set up on the "Exchange
Assembly" program. This allows you to exchange a faulty assembly with one
that has been repaired, calibrated, and performance verified by the factory.
The cost is significantly less than that of a new assembly.

Exchange and Replacement Assemblies Part Numbers

Exchange Assemblies Part

Number Description

E3459-69401 Programmed emulation probe

16600-69515 Emulation module

Replacement Assemblies Description

Part Number

0950-3043 Power supply (for emulation module only)

E3459-61601 20-pin cable

E3459-61602 14-pin cable

E3459-61603 20-pin cable

E3496-66502 Processor probe loopback test board

E3459-66502 Targetinterface module (ARM7TDMI JTAG
board)
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To clean the emulator

If the emulator requires cleaning:
1 Remove power from the instrument.

2 Clean the instrument using a soft cloth that has been moistened in a
mixture of mild detergent and water.

3 Make sure that the instrument is completely dry before reconnecting it
to a power source.
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Glossary

Analysis Probe A probing solution
connected to the target
microprocessor. It provides an
interface between the signals of the
target microprocessor and the inputs
of the logic analyzer. Formerly called
a “preprocessor.”

Elastomeric Probe Adapter A
connector that is fastened on top of a
target microprocessor using a
retainer and knurled nut. The
conductive elastomer on the bottom
of the probe adapter makes contact
with pins of the target
microprocessor and delivers their
signals to connection points on top of
the probe adapter.

Emulation Module An emulation
module is installed within the
mainframe of a logic analyzer. It
provides run control within an
emulation and analysis test setup.
See Emulation Probe.

Emulation Probe An emulation
probe is a standalone instrument
connected via LAN to the mainframe
of a logic analyzer or to a host
computer. It provides run control
within an emulation and analysis test
setup. Formerly called a “processor
probe” or “software probe.”See
Emulation Module.

Extender A part whose only

function is to provide connections
from one location to another. One or
more extenders might be stacked to
raise a probe above a target
micoprocessor to avoid mechanical
contact with other components
installed close to the target
microprocessor. Sometimes called a
“connector board.”

Flexible Adapter Two connection
devices coupled with a flexible cable.
Used for connecting probing
hardware on the target
microprocessor to the analysis probe.

General-Purpose Flexible
Adapter A cable assembly that
connects the signals from an
elastomeric probe adapter to an
analysis probe. Normally, a male-to-
male header or transition board
makes the connections from the
general-purpose flexible adapter to
the analysis probe.

High-Density Adapter Cable A
cable assembly that delivers signals
from an analysis probe hardware
interface to the logic analyzer pod
cables. A high-density adapter cable
has a single Mictor connector that is
installed into the analysis probe, and
two cables that are connected to
corresponding odd and even logic
analyzer pod cables.
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High-Density Termination
Adapter Cable Same as a High-
Density Adapter Cable, except it has
a termination in the Mictor
connector.

Jumper Moveable direct electrical
connection between two points.

Mainframe Logic Analyzer A logic
analyzer that resides on one or more
board assemblies installed in an
Agilent Technologies 16500, or
16600A/700A-series mainframe.

Male-to-male Header A board
assembly that makes point-to-point
connections between the female pins
of a flexible adapter or transition
board and the female pins of an
analysis probe.

Preprocessor See Analysis Probe.

Preprocessor Interface See
Analysis Probe.

Probe adapter See Elastomeric
Probe Adapter.

Processor Probe See Emulation
Probe.

Prototype Analyzer The Agilent
Technologies 16505A prototype
analyzer acts as an analysis and
display processor for the Agilent

Technologies 16500B/C logic analysis
system. It provides a windowed
interface and powerful analysis
capabilities. Replaced by Agilent
Technologies 16600A/700A-series
logic analysis systems.

Run Control Probe See Emulation
Probe and Emulation Module.

Setup Assistant A software
program that guides a user through
the process of connecting and
configuring a logic analyzer to make
measurements on a specific
microprocessor.

Shunt Connector. See Jumper.

Software Probe See Emulation
Probe.

Solution Agilent Technologies’ term
for a set of tools for debugging your
target system. A solution includes
probing, inverse assembly, the
Agilent Technologies B4620B Source
Correlation Tool Set, and an
emulation module.

Stand-alone Logic Analyzer A
standalone logic analyzer has a
predefined set of hardware
components which provide a specific
set of capabilities. It is designed to
perform logic analysis. A standalone
logic analyzer differs from a
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mainframe logic analyzer in that it
does not offer card slots for
installation of additional capabilities,
and its specifications are not
modified based upon selection from a
set of optional hardware boards that
might be installed within its frame.

Target Control Port An 8-bit, TTL
port on a logic analysis system that
you can use to send signals to your
target system. It does not function
like a pattern generator or emulation
module, but more like a remote
control for the target’s switches.

Target Interface Module A small
circuit board which connects the 50-
pin cable from an emulation module
or emulation probe to signals from
the debug port on a target system.

TIM See Target Interface Module.

Trigger Specification A set of
conditions that must be true before
the instrument triggers. See the
printed or online documentation for
your logic analyzer for details.

Transition Board A board assembly
that obtains signals connected to one
side and rearranges them in a
different order for delivery at the
other side of the board.

1/4-Flexible Adapter An adapter

that obtains one-quarter of the
signals from an elastomeric probe
adapter (one side of a target
microprocessor) and makes them
available for probing.
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A

address, IP
IP address, 30
altitude specifications, 105
analysis probe
definition, 147
assistant
See setup assistant

B

BNC
break in, 80
LAN, 29
trigger out, 80
BNC, LAN, 104
BOOTP, 35
bootp, 36
built-in commands
configuration, 66
LAN configuration, 32
list of commands, 118

C

cable

LAN, 38

replacing, 144

serial, 42
CD-ROM, installing software from,

53

cf commands, 66
cleaning, 145
clocks

specifications, 104
configuration, 63

emulation module, 64, 68
connecting, 17
connecting to the target system, 55
connection, 20, 130, 133

host workstation, 27

connector
10BASE2, 29, 104
10BASE-T, 29, 104
JTAG, 86
JTAG, designing, 84
JTAG, levels, 123
serial, 104
connector board, 147

D

data communications
specifications, 104
DCE or DTE selection and RS-232
cable, 132
debug port
connecting to, 57
debugger
writing, 120
debuggers
configuration, 68
driver firmware error, 124

E

elastomeric probe adapter
definition, 147
Emulation Control Interface
configuration, 65
emulation module
configuration, 68
definition, 147
description of, 3
using debugger, 68
emulation probe
definition, 147
environmental characteristics
emulation module, 105
equipment supplied
emulation migration, 24
ethernet address, 33
extender, 147

F

firmware
version, 109, 110
flexible adapter
definition, 147

G

gateway address, 33, 130
general-purpose flexible adapter
definition, 147

H

high-density adapter cable
definition, 147

high-density termination adapter
definition, 148

host computer
connecting to, 27

I

IEEE 802.3, 29
init command, 124
internet address, 30
IP address, 29, 30, 33, 129, 130
1IPC
connecting to, 27

J

JTAG
designing connector, 84
jumper, definition, 148

L

lan command, 32
LAN connection problems, 130,
140, 141

LAN interface, 29

LAN parameters, configuring
BOOTP, 35
methods, 29
terminal interface, 32
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link beat, 38
link level address, 33, 36

M

mainframe logic analyzer
definition, 148

male-to-male header
definition, 148

mask, subnet, 131

MAU, 29, 104

memory
testing, 127

minimum equipment, 16

monitor, 71

N
noise, reducing, 86

(0]

operating characteristics
emulation module, 105
overview, 11, 64

P

performance verification test, 137
ping command, 130
POL light, 117, 130
port number, 33
power on/off sequence, 17
power supply, 17
power up self test, 134
preprocessor

See analysis probe
problems, 113
problems, LAN, 130
problems, RS-232, 133
processor support package, 53
prompts, 120

list of, 120

troubleshooting, 124

prototype analyzer
definition, 148

R

real-time runs, configuring, 70, 71
register commands, 121
requirements, 16
RESET

configuring, 78

light, 117
run control tool

See emulation control interface

S

self test, 134
sequence, 20
serial connection
DCE or DTE selection, 132
number of connections, 133
problems, 133
setting up, 40
verifying, 44
service ports, 33
service, how to obtain, 143
setup
See configuration
setup assistant, 111
definition, 148
signals
JTAG, 85
signals, expected levels, 123
slow clock, 115
software probe
See emulation probe
solution
definition, 148
specifications
altitude, 105
clock, 104
data communications, 104
temperature, 105
trigger in/out, 104

StarLAN, 29, 38
status lights, 116, 118, 134
subnet mask, 29, 130, 131
switches, 36
bootp, 36
LAN configuration, 32, 38
serial configuration, 40

T

target control port
definition, 149
target interface module, 57
target interface module (TIM)
definition, 149
target system
connecting to, 56
problems with, 121
TCP, 33
TDO, TDI signals, 86
telnet, 38, 129
temperature specifications, 105
terminal (MS Windows program),
133
terminal interface, 38
built-in commands, 118
LAN parameters, setting, 32
ThinLAN, 29, 104
trace length, 86
transition board
definition, 149
trigger
in/out specifications, 104
troubleshooting, 115
TX light, 117

U
Updating Firmware, 108

Vv

versions
emulation module firmware, 110
emulation probe firmware, 109
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i

wizard
See setup assistant
workstation
connecting to, 27
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DECLARATION OF CONFORMITY

according to ISO/IEC Guide 22 and EN 45014

Manufacturer's Name: Agilent Technologies

Manufacturer's Address: Digital Design Product Generation Unit
1900 Garden of the Gods Road
Colorado Springs, CO 80907 USA

declares, that the product

Product Name: Processor Probe
Model Number(s): E3459A
Product Option(s): All

conforms to the following Product Specifications:

Safety: IEC 1010-1:1990+A1 / EN 61010-1:1993
UL31M1
CSA-C22.2 No. 1010.1:1993

EMC: CISPR 11:1990/ EN 55011:1991 Group 1 Class A
IEC 555-2:1982 + A1:1985 / EN 60555-2:1987
IEC 555-3:1982 + A1:1990 / EN 60555-3:1987 + A1:1991

IEC 801-2:1991 / EN 50082-1:1992 4kV CD, 8kV AD
IEC 801-3:1984 / EN 50082-1:1992 3V/m, {1kHz 80% AM, 27-1000 MHz}
IEC 801-4:1998 / EN 50082-1:1992 0.5 kV Sig. Lines, 1 kV Power Lines

Supplementary Information:

The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC and the EMC
Directive 89/336/EEC and carries the CE marking accordingly.

This product was tested in a typical configuration with Agilent Technologies test systems.

Colorado Springs, 02/18/98 K(A/L{A)Adéﬁ

Ken Wyatt / Product Regulations Manager

European Contact: Your local Agilent Technologies Sales and Service Office or Agilent Technol ogies GmbH, Department ZQ /
Standards Europe, Herrenberger Strasse 130, D-71034 Boblingen Germany (FAX: +49-7031-14-3143)




Product Regulations

Safety

EMC

Sound Pressure
Level

IEC 1010-1:1990+A1/EN 61010-1:1993

UL3111

CSA-C22.2 No. 1010.1:1993

This Product meets the requirement of the European Communities (EC) EMC
Directive 89/336/EEC.

Emissions

Immunity

N/A

EN55011/CISPR 11 (ISM, Group 1, Class A equipment)
IEC 555-2 and IEC 55-3

EN50082-1 Code’ Notes?
IEC 801-2 (ESD) 8kV AD 1 1

IEC 801-3 (Rad.) 3V/m 1

IEC 801-4 (EFT) 1kV 1

Iperformance Codes:

1 PASS - Normal operation, no effect.

2 PASS - Temporary degradation, self recoverable.

3 PASS - Temporary degradation, operator intervention required.
4 FAIL - Not recoverable, component damage.

2 .
Notes:

1 The target cable assembly is sensitive to ESD events. Use standard ESD

preventative practices to avoid component damage.
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Safety

This apparatus has been designed
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TEC Publication 1010, Safety
Requirements for Measuring
Apparatus, and has been supplied
in a safe condition. Thisis a
Safety Class I instrument
(provided with terminal for
protective earthing). Before
applying power, verify that the
correct safety precautions are
taken (see the following
warnings). In addition, note the
external markings on the
instrument that are described
under "Safety Symbols."

Warning

¢ Before turning on the
instrument, you must connect the
protective earth terminal of the
instrument to the protective
conductor of the (mains) power
cord. The mains plug shall only be
inserted in a socket outlet
provided with a protective earth
contact. You must not negate the
protective action by using an
extension cord (power cable)
without a protective conductor
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outlet is not sufficient protection.

¢ Only fuses with the required
rated current, voltage, and
specified type (normal blow, time
delay, etc.) should be used. Do
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circuited fuseholders. To do so

could cause a shock of fire hazard.

 Service instructions are for
trained service personnel. To
avoid dangerous electric shock,
do not perform any service unless
qualified to do so. Do not attempt
internal service or adjustment
unless another person, capable of
rendering first aid and
resuscitation, is present.

e [f you energize this instrument
by an auto transformer (for
voltage reduction), make sure the
common terminal is connected to
the earth terminal of the power
source.

e Whenever it is likely that the
ground protection is impaired,
you must make the instrument
inoperative and secure it against
any unintended operation.

¢ Do not operate the instrument
in the presence of flammable
gasses or fumes. Operation of any
electrical instrument in such an
environment constitutes a definite
safety hazard.

¢ Do not install substitute parts or
perform any unauthorized
modification to the instrument.

e Capacitors inside the
instrument may retain a charge
even if the instrument is
disconnected from its source of
supply.

Safety Symbols

Instruction manual symbol: the
product is marked with this
symbol when it is necessary for
you to refer to the instruction
manual in order to protect against
damage to the product.

)

Hazardous voltage symbol.
|

Earth terminal symbol: Used to
indicate a circuit common
connected to grounded chassis.

WARNING

The Warning sign denotes a
hazard. It calls attention to a
procedure, practice, or the like,
which, if not correctly performed
or adhered to, could result in
personal injury. Do not proceed
beyond a Warning sign until the
indicated conditions are fully
understood and met.

CAUTION

The Caution sign denotes a
hazard. It calls attention to an
operating procedure, practice, or
the like, which, if not correctly
performed or adhered to, could
result in damage to or destruction
of part or all of the product. Do
not proceed beyond a Caution
symbol until the indicated
conditions are fully understood or
met.
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Technologies specifically
disclaims the implied
warranties of merchantability
or fitness for a particular
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Exclusive Remedies
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remedies. Agilent Technologies
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